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This guide is the absolute Toon Boom Animate kick 
start kit covering all the basics of the software that you 
need to get started on your own animation projects.

Discover Animate in 12 lessons! Use the sample 
material provided or if you prefer, use your own. The 
sample material will help you follow the different 
exercises contained in this guide.

To install the sample material 
provided, simply follow 
the installation 
instructions on the 
installation disc, at the end 
of this chapter or download 
them from our website at 

toonboom.com.

The keyboard shortcuts used in this guide are based on 
the Adobe®Flash® shortcut set.

If you are using Animate Pro, you have access 
to additional exclusive features that are not available in 
Animate. The Animate Pro Getting Started Guide adds  
chapters and lessons covering these extra features.

IntroductionChapter 1 
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Your Training Outline
Are you ready? Let’s take a first glance at the training 
outline covered in this guide.

Chapter 2 Creating Your Own Animation
Get to know the basics of Animate while you create a 
butterfly from some simple shapes and animate it.

Chapter 3 Gathering Content 
Learn how to import external content such as multilayer 
PSD and QuickTime movies to build a scene out of it.

Chapter 4 Designing a Character
Learn to use the basic drawing tools available in Animate 
as well as many helpful features for the design tasks. 
Starting from the rough design through to the Ink and 
Paint process.

Chapter 5 Painting Your Character
Get to know the different painting tools, the Tools 
Properties and the Palette concept in Animate while 
painting a character.

Chapter 6 Using Symbols to Animate a 
Skateboard
Learn the concept of Symbols in Animate, and how to use 
them while creating a simple skateboarding animation.

Chapter 7 Creating a Simple Hand-Drawn 
Animation
Learn the different tools and features available to you in 
Animate that let you easily create paperless animation.

Chapter 8 Building a Cut-out Puppet
Learn the different steps and tasks involved in creating a 
cut-out puppet, from breaking it down to rigging it.

Chapter 9 Animating Your Puppet
Learn how to use the different animation tools available in 
Animate while animating a cut-out puppet.

Chapter 10 Creating a Multiplane and 
Animating the Camera
Learn how to use Animate’s different views and tools to 
create multiplane effects and give the illusion of depth and 
3D space to your project.

The aspect ratio is the relation between the width and height of any scene, frame or film format. The TV ratio 
is 4:3 and the widescreen is 16:9. 
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Chapter 11 Sound and Lip-Sync
Get to know the different sound and lip-sync tools while 
creating a quick lip-sync animation. Learn how you can 
share your animation by exporting it in a QuickTime movie 
format.

Chapter 12 Morphing a Flag
Get to know the Morphing tools and features while you 
create an animation of a flag.

Chapter 13 Creating Effects (Animate 
Only)
Learn how to enhance the quality of your projects using 
the effect layers in the Timeline view.

* Note that this chapter is ONLY valid for Animate. In  
Animate Pro, the effects are not created using the Timeline 
view, but using the Network view, exclusive in Animate 
Pro. Refer to Chapter 5 of the Animate Pro Getting Started 
Guide to learn how to add effects using Animate Pro.

The Ease-in is a gradual acceleration in the action.
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Interface Highlights
It’s important that you familiarise yourself with the 
interface before you start to navigate through 
Toon Boom Animate. As you work through this guide and 
learn to use the software, you can refer to the following 
section whenever you need to identify a specific view or 
toolbar.

Note: The numbers in this list correspond to the numbers 
in the interface diagram on the following page.

1. Top Menu 
Contains most of the commands available in the 
software in the Top menu.

2. Playback Toolbar 
This is used to play your animation, loop it, 
change the playback range and temporarily 
modify the frame rate.

3. Workspace Toolbar 
This is used to customize and load different 
workspaces.

4. Colour View 
This is used to select, create and modify colours. 
You can also create specific palettes and palette 
styles for your characters.

5. Library 
This is used to store and reuse Symbols and 
templates. Anything you create in Animate, you 
can store in the Library.

6. Tool Properties View 
Contains the options related to the currently 
selected tool. When you work with a tool, you will 
often use the Tool Properties view to either alter a 
selection or change the tool’s behaviour.

7. Timeline View 
This is mainly used to add layers, change the 
timing, create effects* and order your elements. 
You can also change the scene length, create 
Symbols and templates, enter Symbols and add 
keyframes.

8. Tools Toolbar 
Contains most of the drawing and animation 
tools you will use when working in Animate.

9. Camera View 
This is the centre of your operations. This is where 
you draw, paint, animate, position your elements, 
and view the animation playback and results of 
any effects you add.

* Available ONLY in Animate. For Animate Pro, see the Animate Pro Getting Started Guide.
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In Animation, the Ease or velocity, is the acceleration or deceleration of a motion. This can be a motion created 
by a function curve or a series of animated drawings. Other common terms used are slow-in and slow-out.
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Timeline View Legend
The Timeline view is the main view used to adjust the 
timing of your drawings, connect effects* and order layers. 

Refer to the following legend to learn about the Timeline.

Note: The numbers in this legend correspond to the 
numbers in the Timeline View on the following page.

1. Layers used in the Timeline view: 

•  Drawing

•  Peg

•  Mask

•  Camera

• Effect
•  Sound

2.  
When position keyframes are added on a Drawing 
layer, they are displayed as black squares. When 
interpolation is created between these keyframes, 
an arrow is displayed. 

3.  
An exposed drawing is represented by a grey block. 
Exposing the drawing for several frames extends the 
grey block. Exposing a second drawing displays a 
new grey block. 

4.  
An exposed Symbol is represented by a small film 
frame. Exposing a Symbol for several frames 
extends the film frame. Exposing a second Symbol’s 
frame displays a new film frame. 

5.  
When a Morphing sequence is created, it is 
represented by a series of arrows. The key drawings 
are still represented as grey blocks, but the 
morphed in-betweens are shown as a series of grey 
arrows.

6.  
When a Peg layer contains keyframes, they are 
represented by black squares. A Peg layer is a 
motion path which you can attach drawing layers to. 
When an interpolation is created, a straight line is 
displayed between the keyframes.

* Available ONLY in Animate. For Animate Pro, see the Animate Pro Getting Started Guide.
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Buttons
In this guide, you will find tools that you will use frequently. 
Most tools have a button. Recognizing these allows you 
access the tools faster. You can find the most common 
ones on the next page.

• Edit: The Edit tools are used to copy, cut, paste, 
delete a selection and cancel actions.

• File: The File tools are used to import images, 
open, close and save scenes.

• Animation: The Animation tools are used to 
position and animate your elements on your stage.

• Morphing: The Morphing tools are used to set 
morphing hint points in your morphing sequences.

• Selection: The Selection tools are used to select 
drawing strokes and modify them.

• Drawing: The Drawing tools are used to draw and 
design your characters and backgrounds.

• Drawing Mode: The Drawing Mode tools are used 
to change a drawing tool behaviour.

• Onion Skin: The Onion Skin tool is used to view 
previous and next images.

• Light: The Light tool is used to see your other 
columns in the Drawing view.

• Paint: The Paint tools are used to paint your 
drawings.

• Gap Closing: The Gap Closing tools are used to 
close gaps while painting.

• Gradient: The Gradient tools are used to edit your 
gradient zones.

• View: The View tools are used to navigate in the 
Camera and Drawing views.

• Drawing Markers: The Drawing Markers tools are 
used to identify drawings in the Xsheet view.

• Layers: The Layers tools are used to add different 
types of layers in the Timeline view.

• Flatten: The Flatten tools are used to flatten 
drawing strokes.

• Playback: The Playback tools are used to play back 
your animation.

• Sound: The Sound tools are used to edit and play 
back the sound.

• Ease: The Ease tool is used to adjust your 
animation’s velocity.

• Layout: The Layout tool lets your organize your 
workspace.
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Edit File

Animation Morphing Selection

Drawing Drawing Mode Onion

Light Paint Gap Closing

Gradient View Drawing Markers Layers

Flatten Playback Sound Ease Layout



Sample material setup guide
Templates and sample files will be required for some of the 
lessons in the Getting Started Guide. You must first install 
them, then follow steps to use them in your project.

Step-by-step installation
Go to the following web page: 1. 
toonboom.com/products/animate/eLearning/*
In the Tutorials section download the Sample 2. 
Material package.
Once the package is downloaded, double-click on it 3. 
to launch it.
Follow the installer’s instructions.4. 

To use the templates
To use the templates:

Launch Toon Boom Animate.1. 
Create a new blank project.2. 
In the Library view, click on one of the following 3. 
folders to view the sample material content:

Templates X
Templates > Undone_example_Sample_ X
material
Templates > Completed_examples X

Select a template from the right-hand side of the 4. 
Library view.
Click and drag that template to the left-hand side of 5. 
the Timeline view and drop it where the layers are 
ordered. You can also drop it directly in the Camera 
view.

The template now appears in both the Timeline 
and Camera views and is ready to be animated!
 
 
 
* For Animate Pro go to:
toonboom.com/products/animatepro/eLearning/ 
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Files in the Library view
Here are the types of files you will find in the templates 
folder:

Undone_example_Sample_material• 
Prepared scenes to be completed during 
lessons in the Getting Started Guide.

Completed_examples• 
The resulting scene files for completed 
lessons in the Getting Started Guide.

Templates• 
Various elements that can be used to 
completed some of the lessons in the 
Getting Started Guide.

Extra sample material
You will need to browse and import some extra files from 
the following location*:

Mac• : /Applications/Toon Boom Animate 2/
Templates/Samples
Windows XP• : C:\Documents and Settings\All 
Users\Documents\Toon Boom Animation\Toon 
Boom Animate 2\Templates\Samples 
Windows Vista and 7• : C:\Users\Public\
Documents\Toon Boom Animation\Toon Boom 
Animate 2\Templates\Samples

Files for chapters 3, 5 and 11:
background_tv.psd• 
SuperHero_Soundtracks (3 sound clips)• 
Textures (16 examples)
  
 
 
 
 
 
 
 * For Animate Pro, browse for Toon Boom
    Animate Pro 2 rather than Toon Boom Animate 2.
 

• 
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Creating a basic animation from start to finish in 
Toon Boom Animate is child’s play. In a few easy 
steps you can have a colourful butterfly fluttering its 
way across your screen!

This chapter contains the following topics where you 
will learn how to create new projects, select colours, 
use drawing tools, animate drawings and layers, and 
finally export your project. 

The topics are: 
• Creating a New Project
• Choosing a Colour
• Getting Ready to 

Draw
• Drawing a 

Butterfly
• Animating the 

Butterfly
• Animating the Butterfly 

Layer
• Exporting Your Project

Chapter 2 Creating Your Own Animation
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Creating a New Project
To start any animation, you need to create a new project 
from the Welcome Screen. You can also create new 
projects from the main interface’s File menu.

To create a new scene:
In the 1. Welcome Screen, click on the Choose button 
to select the directory where to save the project.
In the Project Name field, type the name of the new 2. 
project.
In the Resolution list, select a resolution for the 3. 
project. 
Click on the Create Button.4. 

If you need to reopen a project, you can open it using the 
Welcome Screen and clicking on the Open Scene 
command. 

You can also open it in File > Open or by clicking on the 
Open  button in the File toolbar.

1
2

3

4

To create a custom resolution for your scene, refer to the Animate User Guide.
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Choosing a Colour

The first thing you will do is to select a colour for your 
butterfly.

Toon Boom Animate has a colour palette which 
consists of a group of colour swatches. The important 
point to remember is that when a zone is painted with one 
of these colour swatches, that zone is linked to the swatch. 
This means that if you modify the swatch’s colour, the zone 
is updated at the same time! 

Brush FillPencil

The Colour view can keep track of the colour you were 
using the last time you were using either the Brush tool, 
Pencil line tool (Pencil, Polyline, Line, Rectangle or Ellipse) 
or Paint tool.

If you would prefer the Colour view to always  X
use the selected swatch, click on the Link  

button. Once the colours linked, the Link 
button will look like this . 

In the Colour List, select the colour you want  X
to use to draw the butterfly’s wings.

Double-click on a swatch to access the Colour Picker window and modify the swatch’s colour. You can also 
click in the H, S, V, or R, G, B radio buttons to modify the picker display.
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Getting Ready to Draw

To design the butterfly, use the following tools found in the 
Tools toolbar: 

•  Rectangle Tool

Use this tool to draw a rectangle.

•  Contour Editor Tool 

Use this tool to reshape lines.

•  Select Tool 

Use this tool to reposition, scale, skew, rotate 
or delete drawing objects.

•  Paint Tool 

Use this tool to paint the drawings.

Each tool has a set of properties that can be found in the 
Tool Properties view. This way, each time you select a tool, 
you have quick access to the main actions performed with 
this tool.

If you need a drawing tool for a very short period of time, hold down its shortcut key without the [Alt] key 
while you use the tool. Once done, release the hot key.
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Most of the drawing, animation, design and scene setup 
occur in the Camera view. By default, when you draw in the 
Camera view, the lines are anti-aliased using the project 
resolution. To view the lines as plain vector, disable the 
antialiasing property in the Preferences panel.

To start drawing in the Camera view, select the cell 1. 
where you want to draw by clicking on it in the 
Timeline view. 

In the Tools toolbar, select the 2. Rectangle  tool. 

In the 3. Tool Properties view, enable the following 
options:  

 X  Automatically Fill Inside Region

 X  Auto-Flatten

Set the tool size to 0 (zero) so you do not have any 4. 
border around the shape.

Disabling the antialiasing preference. In Windows, Edit > Preferences > OpenGL > Real-Time Antialiasing. For 
Mac, Animate > Preferences > OpenGL > Real-Time Antialiasing. In both cases uncheck the Enable box.
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Drawing a Butterfly
In the Camera view, you will draw a butterfly using the 
Rectangle and Contour Editor tools. This will help you to 
learn how to design characters out of shapes instead of 
just drawing their contours with the Brush tool.
      

1

2

In the Camera view, draw two rectangles to form the 1. 
basic shape of the first wing.

A warning message opens to indicate that you 
are not displaying the invisible lines.

Click on the OK button to ignore the message.2. 
If you want to see the invisible line, select  X
View > Show > Show Strokes or use the 
default keyboard shortcut [D].

    

In the 3. Tools toolbar, select the Contour Editor  

tool.
Select an area of the drawing and move the 4. 
rectangles’ contours to form a butterfly wing in the 
up position.

You can modify a shape by doing one of the following:
Directly moving the point • 
Pulling the stroke between two points • 
Rotating and pulling on a point’s • Bezier handle

 

With the Contour Editor tool, move one of the two Bezier handles by holding down the [Alt] key and nudging 
selected points using the arrow keys. You can add a point by using the [Ctrl] key and clicking.
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In the Tools toolbar, click on the 5. Select  tool and 

select the wing in the Camera view.
Rotate and resize the wing. You can do this using the 6. 
Tool Properties view or by moving the anchor points 
on the selection bounding box.
Using the 7. Ellipse  tool and different colours, draw 

a series of circles and ellipses on the wing.
Select the butterfly wing and select 8. Edit > Group > 
Group to group the wing as one element.

       

If you have finished drawing, disable the 9. 
Auto-Flatten  mode in the Tool Properties view.

Next, draw the butterfly’s body and duplicate the 10. 
first wing by copying and pasting it.
Assemble the butterfly using the Select 11.  tool. 

Bring the wings in front of or behind the body using 
Drawing > Arrange > Bring to Front or Send to 
Back.

You can group a selection by using the default keyboard shortcut [Ctrl]+[G] (Windows), [z]+[G] (Mac) or Edit > 
Group > Group. This shortcut is valid only when working in the Camera or Drawing view.
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Animating the Butterfly 
To animate your butterfly:

In the Tools toobar, select the 1. 
Select  tool.

In the Camera view, select the 2. 
entire butterfly drawing.

Select3.  Edit > Copy Drawing 
Object.

In the Timeline view, select the third cell of the 4. 
butterfly layer.

Paste the butterfly drawing into Camera view using 5. 
Edit > Paste Drawing Object.
To see the previous drawing, enable the 6. Onion Skin  

 button in the butterfly layer. 

 

Scale X, Y 
axis

Scale Y-axis

Scale X-axis

Skew X-axis

Rotate

Skew Y-axis

Next, create a second drawing with the wings in the down 
position and the trick will be done!

In the Timeline view, select cell #3.7. 

In the Camera view, using the 8. Select  tool, select 
the wings and flip them vertically moving the 
bounding box’s anchor points.  
You can use Drawing > Transform > Flip Vertical or 
the keyboard shortcut [5]. 

If you want to extend the exposure of one of your drawing, in the Timeline view, select your drawing and then 
press the [+] key once to increase the drawing’s exposure by one cell.
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Adjust the wings using the 9. Select  tool. 
In the Timeline view, make sure the second butterfly 
drawing is selected and then press the [+] key once 
to increase the drawing’s exposure by one cell. You 
now have a flapping butterfly wing.

In the Timeline view, select the four butterfly cells. 10. 
Right-click and select Create Cycle.

In the Create Cycle dialog box, set the Number of 11. 
Cycles field to 15 to fill the 60 frames length.

You now have an animation 60 frames long. 

Drawing #1

You can easily modify the colour or design of the butterfly, 
if you like. The looped drawings are linked to the original 
ones, so you can modify any of the butterflies with the 
wings in the up position on the layer and all of them will 
update. You can also do the same for the butterflies with 
the wings in the down position. 

You can use the [+] and [-] keyboard shortcuts to increase or decrease a selected cell’s exposure.
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Animating the Butterfly Layer

It’s easy to animate a layer, press two buttons, position 
your drawing and you’re done! 

In the 1. Tools toolbar, enable the Animate  mode. 

The default keyboard shortcut is [Shift]+[A].
In the Tools toolbar, select the 2. Transform  tool. 

The default keyboard shortcut is [Alt]+[Q].
In the Timeline view, go to the first frame.3. 

In the Camera view, select the butterfly and move it 4. 
to the left or right of your screen depending on how 
you designed the butterfly.

When you move the butterfly using the  X
Transform tool a keyframe is automatically 
created in the Timeline view.

Use the bounding box’s corner anchor points to 5. 
scale it down.

The butterfly should be small enough for it to be able to fly 
across the screen over 60 frames.

To animate a layer, use the Transform tool and enable the Animate mode. If you want to reposition a layer 
without animating it, disable the Animate mode.
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In the Timeline view, go to the last frame.6. 

In the Camera view, move the butterfly to the other 7. 
side. You can press [Shift]+[F11]  (Windows)  or 
[z]+[F11] (Mac) to view the path.

By default, the interpolation is automatically calculated 
between the keyframes. There is no need to do anything.

In the Playback toolbar, press the 8. Play  button to 

see your animation.
In the 9. Playback toolbar, press the Loop  button 

to play your animation repeatedly.

You can move between the Timeline frames using the [,] and [.] keys.
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Exporting Your Project
Now that your animation is complete you can export it. 
Toon Boom Animate allows you to export to different 
formats. In this case, we will export the project as an SWF 
format. 

To export the project as a SWF file:
In the top menu, select 1. File > Export > SWF.
In the Export dialog box, click on the Choose button 2. 
to name and select where you will store your movie.
Click on the OK button to start the export process.3. 

There you go! You have just completed your first project 
using Toon Boom Animate.

You can export your projects as image sequences, QuickTime movies, Flash movies (SWF) and Flash videos 
(FLV).
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Toon Boom Animate allows you to draw directly in the 
software, and import external content.

You can import QuickTime videos, pictures, multi-
layered PSD files, as well as AI, SWF and PDF files. 

For this lesson, you can either use your own content or 
the files from the sample material package*. 

Templates/limpa.tpl• 
Mac• : /Applications/Toon Boom Animate 2/
Templates/Samples/ background_tv.psd and 
fireworks.mov
Windows XP• : C:\Documents and Settings\All 
Users\Documents\Toon Boom Animation\
Toon Boom Animate 2\Templates\Samples\ 
background_tv.psd and fireworks.mov
Windows Vista and 7• : C:\Users\Public\
Documents\Toon Boom Animation\Toon 
Boom Animate 2\Templates\Samples\ 
background_tv.psd and fireworks.mov

The topics are: 
• Setting Up the Living Room
• Importing a QuickTime Movie
• Get Limpa to Celebrate
 
 
  * For Animate Pro, browse for Toon Boom Animate Pro 2 rather than Toon Boom Animate 2. 

Chapter 3 Gathering Content
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Setting Up the Living Room

For some of your projects, you will probably want to paint 
your backgrounds in a bitmap editing software such as  
Adobe®  Photoshop® . With Animate, you can import 
multi- layered PSD backgrounds and keep the layers 
separated! 

To start building the scene, we will import a living room 
background. This background has three layers; a wall, a 
television and a chair. We will import the file so that each 
one of these PSD layers will be inserted in a separate 
timeline layer. 

To do this, you must group your layers in Adobe®  
Photoshop® .

In 1. Adobe®  Photoshop® , group your layers. Each 
PSD layer you want on a separate timeline layer 
must be in a different group.

If you want some of your  X PSD layers to be 
integrated in the same timeline layer, insert 
them in the same group.

If you name your groups, their name will be preserved 
once your import the file in Animate.

To import a photo puppet in Adobe®  Photoshop®  put all the hands in one group, the heads in another one and 
so on, so that when you import it in Animate each body part has its own layer containing all of its own pieces.
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In Animate, select 2. Files > Import > Images.
In the 3. Import Drawings dialog box, browse for the 
PSD file to import.
In the Layer section, enable the Create Layer(s) and 4. 
the Create Single Layer Named options.
Disable the Vectorize the Imported Items option.5. 
Click on the OK button.6. 

In the Image to Load field of the 7. Multilayer Image 
Import Settings dialog box, select the All Layer 
Images option.

Select the Transparency Type if applicable.8. 
Press the OK button.9. 

Your background appears in the Timeline view and the 
new layersare named as your PSD groups. The only thing 
left to do is to extend their exposure.

In the Timeline view, select the last cell of each 10. 
layers and press [F5] to extend their exposure.

To vectorize the images you import, learn more about the Alignmentc and Transparency options, refer to the 
Animate User Guide to learn more.
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Importing a QuickTime Movie

If you have a live-action clip you want to integrate into your 
project, you can do it with Animate! Using Animate 
you can import QuickTime movies. This way, you can 
integrate your videos with your animation and push the 
envelop even further!

If your clip is not a QuickTime movie you need to convert it 
to *.mov format first. You can do this using an editing 
software.

In this example, we import a Happy New Year fireworks 
clip that we will position inside the television.

To import a QuickTime movie:
In the top menu, select 1. Files > Import > Movie.
In the 2. Import QuickTime Movie dialog box, browse 
for the movie to import.
Click on the Open button.3. 

Note: Your movie will be transformed into an 
image sequence and a sound layer will be added 
to contain the sound if there is any.

Once the import process is completed, you will 
be asked where and how you want to insert your 
movie’s images.

When you import a QuickTime movie in Animate it is converted to an image sequence. The sound is 
extracted from it and placed in a sound layer. This way, you can modify your clip’s timing.
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In the 4. Import Images dialog box, enable the Create 
Layer(s) and the Create Single Layer Named 
options.
Name your new layer with a relevant name.5. 
Disable the 6. Vectorize the Imported Items option.
Enable the  Create Symbol for Imported Items 7. 
option if you want your movie to be a Symbol.
Click on the OK button to import your image 8. 
sequence. 

 

In the Timeline view, drag and drop the fireworks 9. 
layer below the TV one.

In the Tools toolbar, select 10. 
the Transform  tool and 

disable the Animate  

mode.
In the Timeline view, select 11. 
your QuickTime Movie 
layer.
In the Camera view, resize 12. 
your clip to the tv screen 
size.

Hold the [Shift] key  X
down to maintain 
aspect ratio of the 
movie.

You can extend the scene length by selecting Scene > Scene Length or by dragging the Timeline view’s red 
length bracket.
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Get Limpa to Celebrate
Now that the living room is 
ready for the celebration and 
the television is switched on, 
you can locate the Limpa 
character’s template in the 
Library and import him in the 
scene!
Limpa was previously designed 
and stored in the sample library 
as a template.

A template is a small scene or container that you can 
import into any of your projects and its content will be 
copied in your scene.

In the 1. Library, select the Templates folder and then 
select the Limpa.tpl template.
Drag the selected template to your Timeline view.2. 
Use the Transform 3.  tool to position Limpa on the 

stage.

In the Playback toolbar, press the Play 4.  button to 

play back your animation.

Any drawing or animation your create in Animate can be stored as a template in the Library. Refer to the 
Animate User Guide to learn more about creating templates.
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You can now enjoy your Happy New Year celebration!
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With Animate’s advanced tools, you no longer need 
to draw on paper, scan and clean your drawings. 
You can do all that in the software. Although, if 
you love to draw on paper, Animate allows 
you to import your artwork in your project. 
Using Animate you get the best of both 
worlds.

This chapter contains the following topics 
where you will learn how to use the 
Brush tool, add new layers and 
clean up the drawings. 

The topics are: 
• Drawing Using the Brush Tool
• Other Useful Drawing Tools
• Adding a New Layer
• Tracing Over Your Character
• Adding Thick and Thin Lines 

Chapter 4 Designing a Character
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Drawing Using the Brush Tool

The Brush  tool supports pressure sensitivity and 

several brush tips. 

To keep your work organized, rename the default layer 
with your new character’s name.

In the Timeline view, double-click on the 1. layer name 
and type the new name in the field.
Press [Return] to validate the name. 2. 
Select the cell where you want to draw.3. 

To get a feeling similar to drawing on paper with blue 
pencils, you can modify a colour swatch’s colour and 
transparency. 

Double-click on the colour swatch if you want to 4. 
modify the tint.
To modify the colour’s transparency, slide the 5. Alpha 
cursor to the right or left.

The Contour Optimization smooths the contour of your 
line once the line has been traced. 

Rename a layer by clicking on its name in the Timeline view or in the Layer’s editor. 
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There are several parameters which you can adjust in the 
Brush Properties: 

•  Minimum Size

•  Maximum Size

•  Smoothness

•  Contour Optimization

•  Brush Tips

You are now ready to throw all kinds of ideas onto your 
canvas, which in this case is the Camera view.

In the Camera view, sketch your character.6. 
If you want to draw some shading on your character, 7. 
enable the Draw Behind  option in the Brush Tool 

Properties.

The Smoothness option smooths the initial movement of your line. Increasing the value results in a line with 
less control points. The Contour Optimization smooths the contour of your line once the line has been traced.
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Other Useful Drawing Tools

There are several other useful drawing tools you can use to 
perfect your work such as: 

•  Select Tool 

The Select tool allows to reposition, scale, 
skew, rotate and delete a selection.

•  Cutter Tool 

The Cutter tool allows to select a portion of a 
drawing to reposition it or delete it.

•  Eraser Tool 

The Eraser tool allows to erase any section of 
a line or drawing.

•  Rotate View Tool 

The Rotate tool allows to turn the workspace 
the same as an animation table.

To use the Rotate View  tool, hold down the [Ctrl]+[Alt] 

keys on Windows and [z]+[Alt] on Mac OS.

The default keyboard shortcut to reset the Camera view 
rotation is [Shift]+[X]. Or press the Reset View  button 

in the Camera view’s bottom toolbar.

Refer to the Animate User Guide to learn more about these drawing tools and their properties. Take a 
look at the other exciting and innovative tools available to help you produce some world class animation. 
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Adding a New Layer

Now that your sketch is completed, you will learn how to 
trace over it to get a clean drawing.

In the Timeline view, click on the 1. 
Add Drawing Layer  button to add a new layer 

for your clean drawing.
Rename the layer as 2. clean or any other appropriate 
name.

It is now time to clean your character!

 You can add an unlimited number of layers in the Timeline view.
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Tracing Over Your Character

There are many ways to clean up your character’s sketch.

Here we will demonstrate how to use the Pencil  tool 

and the Polyline  tool to do it, although you could also 

use the Brush  tool for this task.

In the Timeline view, in your 1. clean layer, select the 
cell just above your sketch drawing.

         

Drawing in the clean layer cell does not affect your sketch. 
To make sure that you don’t modify your original drawing, 
you can lock it by clicking on the Lock  button of this 
layer.

You may find it confusing if all of the Colour swatches are 
named sequentially, such as Colour 1, Colour 2, and so on. 
To avoid this confusion you can rename your swatches by 
double-clicking on their name and then pressing the 
[Return] key to validate the name.

Pressing [Return], when you have a series of colour 
swatches, selects the next colour swatch. 

To remove colour swatches from the Colour view, click on the Remove Colour button in the Colour view 
toolbar.
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Using the Polyline  tool to clean your drawing allows 

you to shape your lines easier than if you were tracing 
them by hand using the Brush  tool or the Pencil  

tool.
Click to set a point along your drawing and then pull 2. 
away from it while holding down the left mouse 
button. You will see the line shape as you move the 
handles.

To fine-tune the lines you created with the Polyline  

tool, use the Contour Editor  tool.

Click on the line to see the points appear.3. 
Then, click on a point to select it and move its 4. Bezier 
handles to reshape the line.

Use the Pencil  tool to draw the lines you don’t want to 

do with the Polyline  tool.

To move only one of the two Bezier handles using the Polyline or Contour Editor tool, hold down the [Alt] key.
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Adding Thick and Thin Lines

Since you drew your lines as a central vector type, using 
the Polyline tool and the Pencil tool, your drawing does 
not contain thick and thin lines. There are different 
techniques you can use to add these lines.

The first method is to use the Brush  tool to draw some 

of the lines and change the tip to an oblique shape or use 
a pen tablet which provides you with pressure sensitivity 
and allows you to draw lines of variable thickness.

Drawing with the Brush tool does not allow you to reshape 
your lines as easily as with the Polyline or Pencil tool. The 
Brush tool creates contour vector lines (also known as fills) 
where the vector points are situated on the line’s contour, 
Pencil lines are central vector lines in which the points 
follow the centre of the line.

Central vector lines do not support thick and thin lines, but 
have the same thickness throughout. Contour lines 
support thick and thin lines, but take longer to reshape.

You can convert contour lines to central lines and central lines to contour lines. You can make an invisible line 
by setting the size of the Pencil tool, Ellipse tool, Rectangle tool, Line tool or Polyline tool to 0 (zero).
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The second technique is to convert the central lines to 
contour lines and to add some thick and thin lines by using 
the Contour Editor  tool.

In the Tools toolbar, select the Select 1.  tool.

In the Camera view, select the lines to convert to 2. 
contour lines.
In the 3. Tool Properties view, click on the Convert 
Pencil Lines to Brush Lines  button.

In the Tools toolbar, select the 4. Contour Editor  

tool.
In the Camera view, push the points and contours to 5. 
add the desired thickness.

No matter which tools you use to draw with you must 
finally flatten the lines so that your character outline is a 
single shape instead of being built out of many strokes. 
This makes it easier and lighter to manipulate.

In the Tools toolbar, select the Select 1.  tool.

In the Camera view, select the lines to flatten.2. 
In the 3. Tool Properties view, click on the Flatten  

tool.

There you go! You now know how to design and clean a 
complete character in Toon Boom Animate.

If you plan to use this character as a cut-out puppet in a later step, you can decide not to flatten your lines for 
an easier breakdown process. Refer to the Creating a Cut-out Puppet chapter for more information.
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One of the greatest benefits of using Animate are its 
colour palettes. With Animate, you can create a group 
of colours specifically for your character which will stay 
with it throughout your project. You can change the 
colours at any time.

You can use the character you drew previously or a 
character model from the sample material package*:

Templates/Joe_unpainted.tpl• 
Mac• : /Applications/Toon Boom Animate 2/
Templates/Samples/ Textures
Windows XP:•  C:\Documents and Settings\All 
Users\Documents\Toon Boom Animation\Toon 
Boom Animate 2\Templates\Samples\Textures
Windows Vista and 7:•  C:\Users\Public\
Documents\Toon Boom Animation\Toon Boom 
Animate 2\Templates\Samples\Textures

The topics are:
• Creating a Colour Palette
• Painting the Character
• Closing Gaps
• Creating Gradient Colours
• Painting With Bitmap Textures
• Editing Gradients and Textures
• Creating a Palette Style
 
  * For Animate Pro, browse for Toon Boom Animate Pro 2 rather than Toon Boom Animate 2. 

Chapter 5 Painting Your Character
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Creating a Colour Palette

You don’t need to use the default palette to paint all of 
your drawings and animations. You can create a small 
group of colours specifically for your character! This helps 
to keep your work organized by keeping your character’s 
colours together. These groups of colours are known as 
colour palettes.

To access the Palette List, in the Colour view, click 1. 
on the Show Palette List View  button.

In the Colour toolbar, click on the New Palette 2.  

button.

In the 3. Palette Browser dialog box, name your 
palette with a relevant name.
Click on the OK button to validate the palette’s 4. 
creation.

Refer to the Creating Your Own Animation chapter to review the Colour view basics.



Painting Your Character   -   Creating a Colour Palette  51

If you are not using the default palette, remove it from the 
Palette List. 

Note: The default palette itself will not be deleted and it 
can always be brought back later.

In the Colour view, select the default palette.5. 
In the Colour view toolbar, click on the 6. Remove 
Palette  button.

You are now ready to add colour swatches to your new 
palette.

In the Colour view, click on the 7. Add Colour  

button to add new colour swatches.
Double-click on a colour swatch to open the Colour 8. 
Picker window and modify the colour.
Click on the colour swatch’s name to 9. rename it.

Remember that when you paint a zone with a specific colour swatch, the zone is linked to this colour swatch. 
When you modify the swatch, the zone will be updated along with it.
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Painting the Character

In the Tools toolbar, select the 1. Paint  tool.

In the Colour view, select the colour swatch 2. 
corresponding to the zone your want to paint.

In the Camera view, paint the zone.3. 
Repeat this process until the drawing is entirely 4. 
painted.

With the Paint tool you can only paint closed zones. If a zone is open, you will need to close it either with the 
Brush tool or the Close Gap tool.
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There are many Paint  tool options available. You can 

set these options in the Tool Properties view:
• Paint

Paints everything it touches
• Paint Unpainted

Paints only unpainted zones
• Repaint

Paints only already painted zones
• Unpaint

Unpaints everything it touches

To quickly paint a series of drawings, it is advantageous to set the Paint tool’s painting option to Paint 
Unpainted.
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Closing Gaps

If your drawing has a gap in a line, the Paint  tool 

cannot paint the unclosed zone. First you need to close it. 
You can do this using the automatic Close Gap mode or 
the Close Gap tool. You could also use the Brush, Contour 
Editor or Pencil tools.

To use the Close Gap tool:
In the Tools toolbar, select the 1. Close Gap  tool.

Press [D] to display the invisible strokes.2. 
In the Camera view, trace a stroke near to the gap.3. 

You can also use the automatic close gap available in the 
Paint’s Tool Properties. You can choose the size of the gap 
that you want the system to automatically ignore while 
painting. Gap closing only occurs when you paint using the 
Paint tool.

To use the automatic Close Gap mode:
In the Tools toolbar, select the 1. Paint  tool.

In the 2. Tool Properties view, select one of the gap 
closing options from the drop-down list.
In the Camera view, paint your drawing.3. 

You can set the automated gap closing to Close Small Gap. Selecting Close Large Gap could result in not 
painting all of the small areas in your drawings.
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Creating Gradient Colours

Animate adds life to your drawings by letting you paint 
with both gradient and solid colours. 

Creating a gradient colour is so easy to do. You can even 
modify one of your existing colour swatches. As a bonus 
you can see the result on your painted character as you 
adjust the gradient!

In the Colour view, double-click on the colour 1. 
swatch to transform it into a gradient.
In the Colour Picker window, enable the Gradient 2. 
option.
Choose a Linear or Radial gradient.3. 
Click on the gradient arrows and adjust their 4. 
position and colour.

Refer to the Animate User Guide to learn more about editing gradient swatches.
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Painting With Bitmap Textures

After painting with solid and gradient colours, you can also 
paint with bitmap textures.

In the Colour view, click on the Add Texture 1.  

button.
Browse for a 2. PSD or TGA picture.
In the Tools toolbar, select the 3. Paint  tool.

In the Colour view, click on the 4. Paint Colour  

button.
In the Colour view, select your new texture swatch.5. 
In the Camera view, paint the desired zone.6. 

 

You can use any photo or textured image in your computer and paint your animation with it. It only needs to 
be in PSD or TGA format.
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Editing Gradients and Textures
Squash and Stretch

Rotate

Skew

Position

After you paint a zone with a gradient or texture colour, 
you can reposition and adjust it.

In the Tools toolbar, select the Edit Gradient/Texture 1. 
 tool.

In the Camera view, click on the gradient or texture 2. 
zone to modify.
Using the tool’s anchor points, modify the gradient 3. 
or texture’s size, angle and position.

If you like the gradient position you made with the Edit 
Gradient/Texture  tool, you can store it so that next 

time you paint with a gradient or a texture it will be 
positioned the same.

In the Tools toolbar, select the Select 1.  tool and 

select the desired gradient zone.
In the Select 2.  tool’s Tool Properties view, click on 

the Store Gradient Colour  button.

To use the stored gradient, in the 3. Brush or Paint Tool 
Properties view enable the Use Stored Gradient 
Colour option.

 

You can copy and paste a gradient/texture position using the Edit Gradient/Texture tool. This can be very 
handy when you have a hand-drawn animation painted with gradient colours.
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Creating a Palette Style

Day Palette Style Night Palette Style

You can create palette styles for your character such as a 
Day palette or a Night palette.

A palette style is created by cloning your original palette. 
This links the colour swatches to the same zones as the 
original palette. This has the advantage of letting you 
change the colours in your cloned palette, and then by 
replacing the original palette with the clone the character’s 
colours will update automatically without you having to 
repaint!

To access the Palette List, in the Colour view, click 1. 
on the Show Palette List View  button.

In the Colour view, click on the Menu 2.  button 
and select Palettes > Clone.
In the 3. Clone Palette dialog box, name the palette 
appropriately. We recommend keeping the suffix 
 -clone as part of the palette’s name. For example, 
Joe-clone.
In the Colour View, select the new cloned palette.4. 

 

You can use the Tint Panel to modify all of your palette’s colours at once. You do not have to modify them 
individually.
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To modify the cloned palette colours, edit them one at a 
time in the Colour Picker window or you can offset all of 
the colours at once using the Tint Panel window.

The Tint Panel window allows you to offset or blend a 
colour in all your selected swatches.

In the Colour view, click on the Menu 1.  button 
and select Palettes > Tint Panel.
In the Tint Panel window, select the palette to 2. 
modify, in this case, your clone palette.
In the Colour list, select the swatches you want to 3. 
modify.
Choose between Offset or Blend mode.4. 
If you are using the Blend mode, increase the 5. 
blending amount.
Modify the offset or blend tint.6. 
Click on the Apply button to apply the changes to 7. 
your palette or click on the Reset button to reset the 
changes.

If you want to use your painted character as a colour model, you can store it in your library as a template. 
Refer to the Animate User Guide to learn more about creating templates.
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With Symbols, Toon Boom extends Animate’s 
spectacular animation capabilities even further. For 
example, by using Symbols, you can build animated 
props and manipulate them as a unified object. 

This chapter contains the following topics where you 
will learn how to create, combine, extend, edit, cycle 
and animate Symbols. 

The topics are: 
• Creating the Skateboard
• Animating the Smoke Cycle
• Creating Symbols
• Adding Smoke to the Wheels
• Building the Skateboard
• Importing the Skateboard
• Animating the Skateboard

Chapter 6 Using Symbols to Animate a Skateboard 
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Creating the Skateboard

In the Timeline view, add a new layer and rename it 1. 
as Skateboard.

Using the tools you learned about in the 2. previous 
lessons, draw the board without the wheels. The 
wheels will be drawn on a separate layer.

In the Timeline view, add a new layer and rename it 3. 
as Wheel.

In the Camera view, draw a wheel to match the scale 4. 
of your board. There is no need to draw it in any 
particular location as you will reposition it later.

To add a new layer in your Timeline view, click on the Add Drawing Layer button in the Timeline layer toolbar.



Using Symbols to Animate a Skateboard    -   Animating the Smoke Cycle  63

Animating the Smoke Cycle
You will create a three drawing animation cycle. The 
animation cycle will be done later after you have imported 
the smoke symbol back into your scene. For now, just 
create the three main drawings.

In the Timeline view, add a new layer and rename it 1. 
Smoke.

In the Camera view, draw the first smoke drawing.2. 

Using the 3. Onion Skin feature, draw the second and 
third drawings.

To change the number of drawings visible in the 4. 
Onion Skin display, push or pull on the Onion Skin 
blue arrows.

Refer to the Animate User Guide to learn how to add effects on your animations. For example, you could 
add a transparency and a blur on your smoke animation.
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Creating Symbols

Animate has a library where you can store your 
drawings and animation for reuse in your scene or sharing 
in your projects.

To reuse drawings or animation in another scene, you need 
to create a template out of them.

A good example of reuse is shown in the skateboard you 
are building, it has four wheels. However, you only need to 
draw one wheel and then reuse it three more times to 
create the three missing wheels. To do this, you must 
create a Symbol out of the wheel and then reimport it into 
your scene.

Creating a Symbol is easy. You only need to select the 
drawings or layers you want to transform and drag them to 
your Library view.

You can either select:
A single drawing• 
Several drawings in a row on a single layer• 
Several drawings in a row on many layers • 
A single layer• 
Several layers• 

To build your skateboard:
In the Timeline view, select the skateboard drawing 1. 
and drag it to the Library view inside the Symbols 
folder.
Select the wheel drawing and drag it to the 2. Library 
view inside the Symbols folder.
Select the three smoke drawings and drag them to 3. 
the Library view inside the Symbols folder. Or use 
the default keyboard shortcut [F8].

All your skateboard elements should now be in the Library 
as Symbols.

Refer to the Animate User Guide to learn more about creating Symbols and templates.
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By right-clicking in Windows (or [Ctrl] + click in Mac OS) on the Symbols folder, you can add a new folder and 
rename it to organize your Symbols.
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Adding Smoke to the Wheels
To add the smoke to each wheel and cycle it, you will enter 
the Wheel Symbol and add the smoke animation. This way 
all the wheels will receive the smoke cycle simultaneously.

In the 1. Library, double-click on the Wheel Symbol. 
You should now be inside the Wheel Symbol where 
you can edit it.

Before importing the Smoke Symbol, you will need to 
extend the symbol length.

In 2. the Timeline view, pull on the scene length red 
bracket and extend it to frame 3.

You will now import the Smoke Symbol:

In the 3. Library, select the Smoke Symbol.
Drag and drop the Smoke Symbol into the 4. 
Timeline’s left section to create a new layer.

You should now see the three smoke frames in your 
Timeline. 

Extend or reduce a symbol’s length by sliding the Timeline’s red bracket to the left or right. Moving it 
towards the left reduces the symbol’s length, while moving it towards the right extends the symbol’s length.
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In the Tools toolbar, disable the 5. Animate mode and 
select the Transform tool.
In the Camera view, position the Smoke layer. If the 6. 
smoke needs to be resized, use the Transform tool’s 
corner anchor points to resize it. The whole 
animation will be scaled together.

As you can see, the wheel‘s exposure is only one frame 
long. You must extend it to three frames.

In the Timeline, select the wheel’s last cell and press 7. 
the [F5] key to extend the wheel’s exposure. Your Wheel Symbol now contains your Smoke Symbol.

In the Library, click on the Wheel Symbol to preview it and 
press the Play  button to view the animation. 

You must save your project in order to save the Symbols stored in your Library.
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Building the Skateboard
Now you need to add the completed wheels inside the 
Skateboard Symbol. This will enable you to manage your 
skateboard as a single object instead of many.

In the Library, double-click on the skateboard 1. 
Symbol.

You will see the name of the Symbol at the top of the 
Camera view. You should now be inside the Skateboard 
Symbol.

Before importing the Wheel Symbols, you will need to 
extend the Skateboard Symbol’s length.

In the Timeline view, pull on the 2. scene length red 
bracket and extend it to frame 3.

From the library, import four Wheel Symbols. Place 3. 
two of the wheel layers above and two more below 
the Skateboard layer. Remember to rename your 
layers correctly.

You can enter a selected symbol by using the default keyboard shortcut [Ctrl]+[E] on Windows 
or [z]+[E] on Mac OS.



Using Symbols to Animate a Skateboard    -   Building the Skateboard  69

In the Tools toolbar, disable the Animate 4.  mode 

and select the Transform  tool.

In the Camera view, position the wheels. If the wheel 5. 
is the wrong size, use the Transform tool’s corner 
anchor points to scale it.

To modify the Wheel Symbol, double-click on a wheel. 
Once inside the Wheel Symbol, modify whatever you want 
to and the four wheels on your skateboard will be 
automatically updated to include the modification.

The skateboard’s exposure is only one frame long. Change 
it to three frames long to match the wheel’s exposure.

In the Timeline view, select the board’s third cell and 6. 
press the [F5] key to extend the skateboard’s 
exposure.

You now have a complete skateboard which you can 
manage as a single object. Get ready to add it to your 
scene and do some tricks! 

When editing a symbol, go back to the scene’s root, click on the word ”Top” at the top of your Camera view.
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Importing the Skateboard
Your completed Skateboard Symbol is ready to animate, 
but first, you must clear the content of the Timeline.

To clear the Timeline:
In the Camera view top area,1.  click on the Top  

button to go back to the scene’s root.
In the Timeline view, select all of your layers.2. 
In the Timeline view toolbar, click on the 3. Delete 
Layers  button.

In the 4. Confirm Delete dialog box, click on the OK 
button.

You are now ready to import your skateboard from the 
library, but before dropping it into your Timeline, you will 
perform an extra operation called: Paste Special. The 
Paste Special command allows to expose the symbol’s full 
length and then create a cycle from it in a several different 
ways. 

Before importing the Skateboard Symbol, you will need to 
extend the scene length.

To import the Skateboard Symbol:
In the Timeline view, pull on the 1. scene length red 
bracket and extend it to frame 60.

In the 2. Library, select the Skateboard Symbol.
Start dragging the Skateboard Symbol toward your    3. 
Timeline view.

Press and Hold down the [Alt] (Windows) or [Ctrl] 4. 
(Mac) key before releasing the Symbol.
Drop the symbol in your Timeline’s left side while 5. 
holding down the [Alt] (Windows) or [Ctrl] (Mac) key.

Once you store a drawing or a layer as a Symbol in your Library, you can delete it from your Timeline. Your 
work will still be available as a Symbol in the Library view.
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In the 6. Paste Special dialog box, enable the Paste 
All Frames of the Symbol (full movie).
Set the 7. Number of Cycles field to 20.
Click on the OK button.8. 

If you forgot to use the Paste Special command when you 
imported, do the following:

In the Timeline view, select the symbol’s frame.1. 
In the top menu, select 2. Edit > Copy. 
In the Timeline, right-click in Windows or 3. 
 [Ctrl] + click in Mac OS and select Paste Special.

The default keyboard shortcut for the Paste Special command is [Ctrl]+[Shift]+[B] (Windows)  
or [Shift]+[z]+[B] (Mac OS X).
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Animating the Skateboard

To complete your project, animate the Skateboard 
Symbol’s position.

In the 1. Tools toolbar, enable the Animate  mode 

and select the Transform  tool.

In the Timeline view, go to the first frame.2. 
In the Camera view, select the Skateboard and 3. 
position it to the left side of the screen.
In the Timeline view, go to the last frame.4. 
In the Camera view, select the Skateboard and 5. 
position it to the right side of the screen.
In the 6. Playback toolbar, click on the Play  button 

to view your completed animation! 

To learn more about animating with Symbols, read the Animating a Cut-out Puppet chapter in the 
Animate User Guide.
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This chapter will focus on the Xsheet view and its 
functionality, but everything can be also achieved in the 
Timeline view if you prefer. 

The topics are: 
• Sketching your Rough Keyposes
• Marking Keyposes in the Xsheet
• Completing the Animation
• Setting the Exposure and 

Testing the Animation
• Cleaning Up the Animation
• Painting the Animation

Chapter 7 Creating a Simple Hand-Drawn Animation
In Toon Boom Animate, you can take advantage of useful tools and features to animate paperlessly. 
Animate lets you create traditional looking animation without paper, pencils or scans. 
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Sketching your Rough Keyposes

The first step in hand-drawn animation is to draw a rough 
sketch. This step lets you create and test your animation. 
You can concentrate on the flow of movement without 
being concerned about the character’s details. You can 
focus on the details during the clean up process later on.

To easily draw your animation, first switch to the 
Hand-Drawn Animation workspace.

In the 1. Workspace toolbar, 
select the Hand-Drawn 
Animation workspace from 
the drop-down menu.

To ensure that your scene is kept well organized, enable 
the Use Current Frame As Drawing Name option. This uses 
the current frame number to name each new drawing.

Press [Ctrl]+[U] (Windows) or [2. z]+[,] (Mac OS X) to 
open the Preferences panel.
In the Exposure Sheet tab, enable the Use Current 3. 
Frame as Drawing Name option.   

Refer to the Discovering the Interface Chapter in the Animate User Guide to learn more about Preferences.
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In the Tools toolbar, select the 4. Brush  tool.

In the Colour view, select a colour swatch. This is the 5. 
colour you are going to use for your sketch. 
Sketching with a light colour helps during cleanup.
In the Xsheet view, select the first cell in the Drawing 6. 
column.

In the Camera view, sketch your first keypose.7. 

The first keypose in the 
walk cycle animation is the 
character with legs and 
arms spread apart. 

To sketch the second keypose of your animation, you will 
use the Onion Skin feature. The Onion Skin lets you see 
the previous and next drawings in washed-out colours. 
This mimics the effect of working with a stack of paper on 
an animation disc and light table. 

In the Tools toolbar, enable the 8. Onion Skin  

feature.
In the Xsheet view, select cell number 4, this will be 9. 
the location of the second keypose.
In the Timeline view, click and drag the blue arrows 10. 
to decide the number of previous and next drawings 
that will appear in the Camera view.

In the Camera view, sketch the second keypose.11. 

You can customize the Onion Skin display options such as the render style and washed out values in the 
Preferences panel under the Drawing tab: Edit > Preferences (Windows) or Animate > Preferences (Mac).



76   Toon Boom Animate Getting Started Guide

The second keypose is the highest point of the walk cycle. 
The leg that was pointing forward on the first one should 
now be straight beneath the character. 

Keypose 1
Cell 1

Keypose 2
Cell 4

Keypose 3
Cell 7

Keypose 4
Cell 10

Using this picture as a guide, complete the four keyposes 
of the simple walk cycle animation.
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Marking Keyposes in the Xsheet

Once you have sketched your keyposes, you should mark 
them in the Xsheet view so you can keep your animation 
organized. Doing this helps you to rapidly determine 
which poses are keyframes, breakdowns or in-betweens.

In the Xsheet view, select the cell containing the first 1. 
keypose.
In the 2. Xsheet Tools toolbar, click on the Mark as Key 
Drawing  button. A Key  marker will appear in 

the cell.
Repeat these steps for each keypose.3. 

You can do the same for breakdown drawings using the 
Mark as Breakdown Drawing  button. This places a 

Breakdown  marker in the selected cell. 

The Mark As In-between Drawing  option will not add a 

marker in the Xsheet view.

Another great way to keep organized is by renaming your 
Xsheet columns.

In the Xsheet view, double-click on the Drawing 1. 
column’s header.
In the Layer Properties dialog box, enter a relevant 2. 
name for the column in the name field.

The Mark as In-between Drawing option will not add a marker in your Xsheet view. It is used to switch from a 
key or breakdown to an in-between drawing by removing the current marker.
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Completing the Animation

It is now time to complete the rough animation. Do this by 
adding two in-between drawings between each keyframe. 

In the Xsheet view, right-click (Windows) or [Ctrl] + 1. 
click (Mac) on any cell between two keyposes, and 
select Drawing > Create Empty Drawing.

This will add a new empty drawing in your layer 
ready for your next pose to be drawn in.

 Add new drawings and sketch 2. 
your poses with the help of 
the Onion Skin feature. 
Continue until you complete 
the walk cycle animation. 

The completed animation should be 
composed of a total of twelve 
different drawings.

Your Xsheet should look like this.

You can use the default shortcuts [F] and [G] to quickly flip through the different poses to get a feel of the 
motion as you sketch your animation.
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Setting the Exposure and Testing 
the Animation

Testing your animation is a crucial step. You will finally see 
the motion in the Camera view and decide if it is good or 
not. 

Before testing the animation, set the exposure and reduce 
the scene length. The correct timing for this simple walk 
cycle example is a double exposure.

In the Top menu, select 1. Scene > Scene Length.
In the 2. Set Scene Length dialog box, extend the 
scene to 24 frames.
In the Xsheet view, 3. 
select your twelve 
drawings, right-click 
and select Exposure > 
Set Exposure to > Set 
Exposure to 2.
Use the [F] and [G] 4. 
keyboard shortcuts to 
flip through your 
drawings.

In the Playback toolbar, click on the 1. Loop  button 

to enable the looping feature.
 To start the playback, click on the Play 2.  button in 

the Playback toolbar.

Refer to the Animate User Guide to learn more about the Playback toolbar features.
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Cleaning Up the Animation

When you are satisfied with your animation, you can begin 
the clean up process. 

In the rough sketch layer, start by cleaning up the key 
poses first and then do the in-between drawings. 

Remember, you can use the Onion Skin feature to verify 
the accuracy of the line between the different poses.

In the Xsheet view, click on the 1. Add Column  

button.
In the Add Columns dialog box, name your column 2. 
Baby_Walk_Clean .
In the Tools toolbars, click on the 3. Brush  button.

If you are animating in the Drawing view you will need to enable the Light Table feature to see your other 
layers. Simply press [Shift]+[L], the default keyboard shortcut.
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In the 4. Tools Properties view, click on the 
Auto Flatten  button and modify the minimum 

and maximum brush sizes. 

The Auto Flatten option flattens your brush lines as you 
draw them. It also simplifies the process of perfecting your 
lines with the Contour Editor tool.

In the Colour view, click on the desired colour 5. 
swatch. Choose a darker colour that will contrast 
with your rough sketch.
In the Camera view, carefully trace the poses.6. 

Refer to the Character Design chapter to learn more on how to perfect your brush line using the Contour 
Editor as well as other useful tips on cleaning up your drawings.
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Painting the Animation

It is time to create a palette for your character and repaint 
the outlines using the colours contained in this palette.

In the top part of the Colour view, click on the New 1. 
Palette  button.

Name your palette in the Palette Browser window.2. 
Rename the default colour swatch and call it 3. Line.
In the Tools toolbar, select the 4. Paint  tool.

In the Tools Properties view, select the 5. Repaint  

mode and click on the  
Apply to Multiple Drawings  button.

The Repaint mode  will make sure that only the lines 

will be repainted, all the empty zones will remain. 

The Apply to Multiple Drawings  option lets you repaint 

the lines on all your drawings at once. 

Refer to the Painting your Character chapter to learn more about colour palettes features and helpful 
painting tips.
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Use the Onion Skin feature to check that no part of the 
animation is left outside the selection.

In the Camera view, make a selection around your 6. 
animation. 

R
+

Now you can add and customize the different colours that 
will be painted in your animation. Be creative! You can 
work with one colour at a time or create them all at once. 
Remember, you can modify them anytime you want 
without repainting your drawings. 

In the bottom part of the Colour view, click on the 1. 
Add Colour  button.

In the Colour view, double-click on the new colour 2. 
swatch.
In the Colour Picker dialog box, pick the desired 3. 
colour and rename your colour swatch.
Repeat these steps for each colour. In this exercise, 4. 
you will need a total of five colours, including the 
line.

Refer to the Painting your Character chapter to learn more about the Colour Picker dialog box and Palettes.
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As soon as your palette is completed you can start to fill 
the zones.

In the 1. Tool Properties view, select the Paint 
Unpainted  mode and click on the Apply to 

Multiple Drawings  button.

The Paint Unpainted mode will only allow the empty zone 
to be painted, preventing lines from being accidentally 
repainted.

The Apply to Multiple Drawings feature is useful when you 
want to paint the central body zone on all of your drawings 
at once. It can also be used on the head zone.

In the Tools toolbar, 2. 
enable the Onion Skin 
feature.
In the Colour view, select 3. 
the colour of the pyjamas.
Click inside the central 4. 
zone you want to paint.
Enable the 5. Apply to 
Multiple Drawings feature 
again and repeat these 
steps for the head.
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To paint the final details, disable the Onion Skin feature so 
you can see one drawing at a time. Use the Paint tool in 
Paint Unpainted mode to speed up the painting process.

In the Colour view, click on the colour swatch.1. 
In the Camera view, click on the zone corresponding 2. 
to the selected colour.
Flip through the drawings by 3. pressing [F] and [G], 
the default keyboard shortcuts.
Repeat these steps for each colour until every zone 4. 
is painted!
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In Toon Boom Animate you will find all the tools you 
ever wished for to build and animate cut-out puppets 
with. A wide variety of breakdown and rigging 
techniques are available since Animate mixes the most 
common and popular concepts.

The topics are: 
• Getting Ready for the Breakdown
• Breaking Down the Main Parts
• Fixing Articulations and Gaps
• Breaking Down the Other Views
• Ordering the Puppet’s Layers
• Setting the Pivots
• Creating Hierarchies
• Ordering Layer Hierarchy
• Adding a Master Peg
• Storing the Puppet in the Library

Chapter 8 Building a Cut-out Puppet
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Getting Ready for the Breakdown

To build your puppet, you will first need the character’s 
picture. It’s even better if your have a complete 
turnaround.

You can use the sample template provided in your library:
Templates > limpa_colour.tpl• 

Breaking down a puppet, consists of cutting the body into 
parts and placing them on different layers so that the 
character becomes articulated.

This tutorial shows you how to build a basic puppet. To get more information on how to build a cut-out 
puppet for a production, refer to the Animate User Guide.
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The breakdown task will be easier if your turnaround views 
are placed in separate cells on the same layer and centred 
in the Camera view. If your puppets are placed one beside 
the other, your final puppets will not align and will need to 
be repositioned.

Start by analyzing your character. What are the main parts? 
If you look at this sample character, Limpa, you can identify 
five main pieces: 

Body• 
Left Arm• 
Right Arm• 
Left Leg• 
Right Leg• 

Later on, you will break those sections in smaller pieces 
such as right hand, left foot, right eye, mouth, head, etc.

Before starting any breaking down, try to decide what will 
be separated from what. For example, to keep this puppet 
simple, we will keep the hat attached to the head, but you 

could decide to separate it from the head to be able to 
animate it independently.

Body

Left ArmRight Arm

Right Leg Left Leg

It is wise to analyze your character before starting to cut it apart. You should be careful what you separate 
from each part. For example, do you want to separate the mouth from the head or not.
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Breaking Down the Main Parts

To breakdown your character, use the Select  tool and 

the Cutter  tool.

You do not need to create new layers when you break 
down your character. They will be created as you go.

Start by creating the main pieces of your character. In this 
case, the body, arms and legs.

Use the Cutter and Select tools to extract the parts, such 
as the arms, from the body and send them to separate 
layers. It does not matter if there are bits from other parts 
or gaps. You will fill and fix those later.

Only do the front or three-quarter view for now. You will 
break down the other views later on.

Note: You could also decide to add layers manually and 
redraw over the model if this technique does not suit your 
needs.

In the Tools toolbar, select the 1. Cutter  tool.

In the 2. Tool Properties view, select the Lasso 
Selection  option.

In the Camera view, trace a selection around the first 3. 
part to separate it. In this case, we will do the right 
arm.

You can hold down the [Shift] key if you want  X
to create a second area.
If you simply click on a line, it will be entirely  X
selected until it meets an intersection.

There are several breakdown techniques. In this lesson, we show you the most commonly used. Refer to the 
Animate User Guide to get more tips about breaking down your puppet.
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In the top menu, select 4. Edit > Create Drawing from 
Drawing Selection. The default keyboard shortcut 
is [F9] (Windows) or [z]+[F9] (Mac OS X).
In the dialog box, type the new layer name.5. 
Disable the 6. Cut Artwork from Source option. When 
you create layers out of your colour model, you do 
not want to cut out the artwork.
Press the OK button to validate.7. 
Repeat the process for each main piece: body, legs, 8. 
arms, head, etc.

Once your main pieces are separated, you can start to 
break them down.

In the Camera view, select the hand from the new 9. 
arm layer. Do not select it from the model.
In the top menu, select 10. Edit > Create Drawing from 
Drawing Selection.
In the dialog box, type the new layer name.11. 
Enable the 12. Cut Artwork from Source option. You 
want to cut the hand away from the arm.
Click on the OK button.13. 
Repeat the process for each part in the character to 14. 
be broken down.

All of the parts should now be in separate layers.

If you forget to send something into your new layer, you can add it afterward. If you select it and use the 
Create Drawing from Drawing Selection option, you can choose the existing layer in the drop-down menu.
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Fixing Articulations and Gaps

Now that all your parts are in their respective layers, it is 
time to fix the rough cuts you did earlier and draw nice 
articulations. To do so, you will use tools such as:

•  Eraser tool

•  Paint tool

•  Contour Editor tool

•  Brush tool

•  Select tool

The body artwork 
continues underneath 
the arm drawing.

When you fix the joints, make sure they overlap properly. 
Remember that the puppet will be animated and each part 
will move and rotate, so make sure not to leave a gap in 
the part underneath.

You could fix the gaps and remove the extra lines while breaking down the parts, but since you will have to fix 
the articulations afterward you are better off doing everything together.
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Top part
Bottom part

Overlapping Zone

The easiest articulation to make is the classic joint. The 
classic joint consists in removing a portion of the outline on 
the overlapping part. For example, the outline around the 
elbow can be erased on the forearm piece. The arm placed 
beneath the forearm will keep its entire outline.

When you assemble those two pieces together, the joint is 
seamless and it looks like a single drawing!

There are other ways to build articulations that are even 
more efficient. This one is the simplest and is often quite 
sufficient.

When you 
assemble the two 
parts, the joint is 
seamless.
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Breaking Down the Other Views

When you have finished fixing your drawings and joints on 
your three-quarter view, you can start breaking down the 
other views such as side and back views.

Since you already broke down a view, the layers already 
exist and are named. You won’t need to do it twice!

The breakdown principle is the same, except that your 
layers already exist.

In the Timeline view, select the cell containing your 1. 
view to breakdown.

In the Tools toolbar, select the 2. Cutter  tool or 
Select  tool.

In the Camera view, trace a selection around the first 3. 
part to separate it.
 

In the Timeline view, disable the checkbox if you want to hide certain layers while working. You can also 
enable the Lock option to avoid selecting or modifying layers.



Building a Cut-out Puppet   -   Breaking Down the Other Views  95

This time, you will add your selection to an existing layer, 
instead of creating a new layer.

In the top menu, select 4. Edit > Create Drawing from 
Drawing Selection.
In the dialog box, select the desired layer from the 5. 
Layer Name drop-down menu.

Disable or enable the  X Cut Artwork from 
Source option depending on what you are 
doing.

Click on the OK button.6. 
Once the view is all broken down, fix the 7. 
articulations and gaps.
Repeat the process for each view.8. 

Once your timeline is completed it should look similar to 
this example.

Refer to the Animate User Guide to find out more about the Create Drawing from Drawing Selection feature.
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Ordering the Puppet’s Layers

It is possible at this point your character’s pieces may show 
up in the wrong order. There are two ways to fix this.

Displayed in Front

Displayed
Behind

To reorder your layers drag them to a higher or lower level 
in the Timeline view. The top layer is displayed in front of 
the others and the bottom one is displayed behind.

In the Timeline view, drag the layer to reorder it and 1. 
drop it in-between the other layers.  
Note: If you drop it on a layer, it will create a parent 
hierarchy, so make sure to drop it in-between layers.

If you select a layer and reposition it, its child layers will follow. There is no need to select all the layers.
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Setting the Pivots

If you want your puppet’s pieces to rotate properly, you 
need to set the pivot points. Even the eyes and mouth 
require you to set their pivots.

Do the following steps for each layer in the Timeline view.

To set the pivots for the Body parts:
1. In the Tools toolbar, select the Pivot  tool.

In the Timeline view, select the cell you want to set 2. 
the pivot for.
In the Camera view, click where you want the pivot 3. 
to be. You can also drag the pivot marker to the 
desired location.
In the Timeline view, select the cell where you want 4. 
to set the new pivot.
In the Camera view move the pivot to the desired 5. 
position.

For more information about pivots, refer to the Animate User Guide.
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Creating Hierarchies

Animate lets you extend your rigging techniques beyond 
normal boundaries and set new standards. You can create 
hierarchies without encapsulating your layers inside each 
other by creating a linked structure between your layers.

To create a hierarchy:
Simply drag the child piece (hand) and drop it ON 1. 
the parent piece (forearm). Then, you can drag the 
parent (forearm) piece on another parent piece 
(arm).

You should create a hierarchy of your arms and legs and 
keep the arms and legs separate from the body. This gives 
you more animation freedom.

Refer to the Animate User Guide to learn more about complete production rigging.
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Ordering Layer Hierarchy
If you created a hierarchy of your arms, legs or other body 
parts, it is possible that you will want a child part, such as 
the hand, to appear in front of its parent. If you move the 
hand layer above the arm layer, you will break the 
hierarchy.

Therefore, to reorder a layer rigged in a hierarchy, nudge it 
forward or backward.

Animate allows you to move your elements in the three 
dimensions:

Up and Down (Y)• 
Left and Right (X)• 
Forward and Backward (Z)• 

The same way you can create multiplane backgrounds 
(depth), you can do a micro nudge on the part to be 
reordered. This makes possible for a reordered part to 
appear in front of the other elements even if its layer is 
behind the other ones in the Timeline view. The Forward-
Backward position can also be animated over time.

Normal Ordering Forward - Backward Ordering

In the Tools toolbar, select the 1. Transform  tool. 

Make sure to disable the Animate  mode.

In the Camera view, select the element to reorder.2. 
To 3. move the element forward, user the default 
keyboard shortcut [Alt] + [Down Arrow] and to move 
the element backward, use the default keyboard 
shortcut [Alt] + [Up Arrow].

To move elements along the Z-axis, use the default keyboard shortcut [Alt] + Up Arrow to move the layer 
backward and [Alt] + Down Arrow to move the element forward.
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Adding a Master Peg
To control all your puppet’s pieces together, you will need 
to add a peg layer at the top of your hierarchy. A peg layer 
is a trajectory on which you can attach your character. This 
way you can scale and reposition your complete character 
for the entire scene or over time. 

In the Timeline view, click on the 1. Add Peg  

button. Name the new peg Master.
In the Timeline view, select all of the layers you want 2. 
to attach to your new peg.

Drag your selection right on the peg layer to parent 3. 
all your character’s pieces to the peg.
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Storing the Puppet in the Library
To store your character in the library you first need to 
create a position keyframe on all your layers and finally 
store it as a template in a sharing library.

In the Timeline view, select the first frame of every 1. 
layer.
In the top menu, select 2. Insert > Keyframe or use 
the default keyboard shortcut [Ctrl] +  [F6]  
(WIndows) or [z]+[F6] (Mac).
In the 3. Library view, select the Animate Library folder, 
right-click (Windows) or [Ctrl]+click (Mac OS) and 
select Right To Modify.
In the Timeline view, select all of your layers and 4. 
drag them into the Animate Library.

You now have a complete cut-out puppet!

To find out more about sharing templates via the library, refer to the Animate User Guide.
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It is time to show off your animation skills! 
Toon Boom Animate was created for you to animate. It 
contains a series of animation tools beyond your 
expectations.

This lesson will cover the basics of cut-out 
animation, but there are an infinite number of 
possibilities. Take a look at the Animate User 
Guide to discover more about animation.

You can use the character you drew 
previously or use a character model from the 
sample material package:

Undone_example_Sample_material > • 
Chapter09_Sample_material.tpl

The topics are: 
• Getting Ready to Animate
• Repositioning the Character
• Animating Using the Transform Tool
• Motion and Stop-Motion
• Swapping Images
• Inverse Kinematics Tool
• Easing

Chapter 9 Animating Your Puppet
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Getting Ready to Animate

To start this lesson, import your character into a new 
scene. 

Create a new Animate project.1. 
From the library, drag your character 2. template into 
the Timeline view’s left side.

Current Image

Onion Skin 1

Onion Skin 2

Before starting your animation, you may want to enable 
the Onion Skin feature to see your previous and next 
frames as a reference.

In the Tools toolbar, enable the  X Onion Skin 
 option.

You can also enable individual layer’s onion  X
skin by clicking on their Onion Skin  icon in 
the Timeline view.

To use a character you previously built in another project and transformed into a symbol, drag the symbol 
into the Animate Library or into any other templates folder and transform it into a template.



106   Toon Boom Animate Getting Started Guide

Repositioning the Character
Now that you have your puppet on your stage, you probably need 
to resize and reposition it to fit your scene. When you need to 
scale down or move your character it’s a good idea to hook 
(attach) the whole puppet to a trajectory.

In Animate, there is a type of layer you can 
add to your timeline allowing you to 
create a motion path or to 
reposition drawings. This 
trajectory layer is called a Peg. 
Any drawing or layer you hook 
to a peg will follow the 
defined motion path, 
rotation, scaling and skewing 
information.

Attaching your puppet to a peg will 
allow you to scale it and reposition it 
without having to do it on all of your different 
parts and pieces. Only one layer will contain 
the position information, this makes your 
animation easier to modify and control.
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If you do not have a top peg layer to control your 
character, you can add one at any time. A peg layer is a 
trajectory on which you can attach your character. This way 
you can scale and reposition your character for the entire 
scene or over time. 

In the Timeline view, click on the 1. Add Peg  

button. The new peg should be called Master.
In the Timeline view, select all of the layers you want 2. 
to attach to your new peg.
Drag your selection right on the peg layer to parent 3. 
all your character’s pieces to the peg.

Next, you need to position your character on the stage by 
moving and scaling it to the correct size. You will not scale 
each layer individually. You either want to do it on the top 
symbol or top peg layer. 

In the Timeline view, select t4. he top peg layer (master 
peg).
In the Tools toolbar, select the 5. Transform  tool 

and disable the Animate  mode.

In the Camera view, position the character.6. 

You can change the Onion Skin display’s look in the Preferences panel. In Edit > Preferences (Windows) or 
Animate > Preferences in (Mac OS X) go to the Drawing tab and change the Onion Skin Render Style option.
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Animating Using the Transform Tool

From now on, the Transform  tool will become your 

most useful tool. You will use it to do most of your 
animation. With the Transform tool, you can select, move, 
scale, rotate, skew, squash and stretch.

In the Timeline view, go to the frame where you 1. 
want to animate your first pose. At this point, it is 
generally the first frame.
In the Tools toolbar, select the Transform 2.  tool 

and enable the Animate  mode.

In the Camera view, select the part you want to 3. 
animate and using the Transform tool’s anchor 
points, move it to its new position.

The pose you are doing is automatically retained. There is 
no need to set a keyframe before moving your parts. As 
soon as you move an element in your Camera view, a 
keyframe is set on the current frame in the Timeline view.

Remember, animation keyframes and drawings are not the 
same thing. If you swap a drawing, you do not need to 
insert a keyframe in your timeline.

To avoid selecting some layers, click on the Lock button in the Timeline view. In the Preferences panel, you 
can go to the Camera view tab and enable the Show Locked Drawings as Outlines to see through them.
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Once your first pose is ready, move on to your next key 
pose. 

In the Timeline view, move to the frame where you 4. 
want your second pose.

If you need to, you can temporarily move the Transform 
tool’s pivot to provide a better rotation or scale centre. 
Simply drag it to where you need it. Next time you select 
your element, it will be back to its original place.

[B]

[B]

You can also select your current selection’s parent layer by 
using the default keyboard shortcut [B]. If you press on it 
repeatedly, you will go up the entire parent chain until the 
master peg or highest layer in the tree.

We recommend that you collapse your master peg and 
add a keyframe after your pose is set. This will lock all of 
the parts in place. You only need to do this once.

In the Timeline view, select the pose and press [F6].5. 

When you select a series of elements using the [Shift] key, the pivot used by the Transform tool will be in the 
first selected element.
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Motion and Stop-Motion

By default, your keyframes will be created as Motion 
Keyframes. This means that Animate automatically 
generates the animation between your poses. 

Because you may not necessarily want that, you can set 
your keyframe creation mode to create Stop-Motion 
Keyframes. Later on, you will be able to convert the 
desired keyframes to Motion Keyframes.

In the top menu, select X  Animation > Stop-
Motion Keyframe.

To switch between Motion and Stop-Motion 
Keyframes:

In the Timeline view, select the keyframes to 1. 
convert.
Right-click (Windows) or [Ctrl] + click (Mac OS X) 2. 
and select Set Stop-Motion Keyframe or Set 

Motion Keyframe .

3. Press the  button to see your animation.

To flip between the keyframes of the selected layer, use the [PgUp] and [PgDown] keyboard shortcuts.
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Swapping Images
Cut-out animation is not only about moving pieces around, 
it’s also about switching some drawings around. For 
example, the ballerina Giselle wants to point her toes.

Instead of rotating the foot, you can swap the regular foot 
drawing for another one that you drew when you built  
your character. You could also create an empty drawing on 
your foot layer and draw a new foot while animating.

To swap a drawing:
In the Camera view, with the Transform 1.  tool, 

select the part you want to swap.
In the 2. Library view, go to the Drawing Substitution 
section.
Move the substitution slider to the right or left to 3. 
scroll through the symbol’s frames or drawings. You 
can also use the keyboard shortcuts [ [ ] and [ ] ].

To quickly swap drawings and frames around, use the [ [ ] and the [ ] ] keyboard shortcuts.
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Inverse Kinematics Tool

The Inverse Kinematics  tool (IK) allows you to pull on 

your character’s extremities, such as the hands and feet, 
and get the rest of the body to follow! 

For the IK to work on your character, there are some 
preconditions:

Your character must have hierarchy chains, for • 
instance, the hand is attached to the forearm and 
the forearm is attached to the arm.
Your character is not required to be entirely done • 
with hierarchy chains. You can have mixed 
technique and it will still work well. IK works with 
characters rigged with symbols, drawing layers and 
pegs.

The IK will work at its best when you lock a part on the 
spot, such as a foot on the floor, and then select the entire 
body or another extremity and move it.

To lock a piece in place, you will use the IK Nail  option. 

While using the IK tool, you can hold down the [Ctrl] key to select any part.
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In the Tools toolbar, select the 1. Inverse Kinematics 
  tool.

In the Camera view, hold down [Ctrl] (Windows) or 2. 
[z] (Mac OS X) and click on the part you want to lock 
down.
In the 3. IK Tool Properties, click on the IK Nail  

button.
In the Camera view, 4. press the [B] key until the body 
is completely selected.
Click on the pieces’ bone to reposition the 5. 
character.
Using the 6. IK tool and the Transform tool, fine-tune 
the character’s pose.

Using the  X IK tool, holding down the [Alt] key, 
you can rotate the selected part without 
moving the rest of the body.

The Inverse Kinematics tool has a lot of options. Refer to the Animate User Guide for more information about 
them.
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Easing

Slow

Fast

Slow

If you used Motion Keyframes in your animation, you will 
certainly want to add some ease in and ease out to smooth 
out your movements and avoid having a robotic animation.

There are two ways to set an ease on your animation: 
directly on the function curve or using the Set Ease For 
Multiple Parameters script.

In the Timeline view, expand the layer 1. 
corresponding to the part you want to set the ease 
on by clicking on the Show Functions  button. If 

the layer is a parent, make sure to expand its 
children by clicking on the Expand Hierarchy  

arrow.
Double-click on the function corresponding to the 2. 
movement you want to ease, such as Angle, for the 
rotation of the thigh. This opens the Function Editor.

You can display function curves in the Function view by clicking on the function layers in the Timeline view.
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In the Function Editor, you can see all of the keyframes 
corresponding to the thigh rotation animation. 

In the function curve, locate the keyframe 3. 
corresponding to the animation you want to ease.
Select the keyframe and pull on the 4. Bezier handle.

The more you pull on it, the stronger the ease  X
will be.

This technique is good when you have to do a simple ease. 
However, when you have a series of layers you want to set 
to the same ease it can be tedious and repetitive. Instead, 
you will use the Set Ease for Multiple Parameters function.

In the Timeline view, collapse the parent peg layer 1. 
containing all of the layers you want to ease.

Right-click (Windows) or [Ctrl]+click (Mac) and select 2. 
Set Ease for Multiple Parameters.

Pull on the Bezier handle and adjust the keyframe’s 3. 
velocity.
Click on the Apply button and then on the Close 4. 
button.

To display a toolbar, select Window > Toolbars and the desired toolbar.



116   Toon Boom Animate Getting Started Guide



  117

One of the most exciting features in 
Toon Boom Animate is the Multiplane, also called 
Z-depth. In the Multiplane you can create 
backgrounds in several layers, spread them on 
the Z-axis, add depth, and then move the 
camera through this environment to create an 
impressive perspective illusion.

 

You can create your own background, use a 
layered PSD file or use a project from the 
sample material package:

Undone_example_Sample_material > • 
Chapter10_Sample_material.tpl

The topics are: 
• Building a Multiplane
• Setting the Multiplane Space
• Animating the Camera

Chapter 10 Creating a Multiplane and Animating the Camera
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Building a Multiplane

To construct a multiplane, you must imagine what a real 
environment is like. Take a look at this picture and imagine 
the camera moving across the space. You will notice that 
objects in the picture will move at different speeds 
depending on where they are in relation to the camera 
lens. 

In this picture the moon is almost stationary and the tower 
in front of it is moving very slowly, but the tower closest to 

 
the foreground is moving faster and the plant in the 
foreground is flying by really quickly.

Building a multiplane requires an understanding of your 
background and which object should be placed in the 
different layers. You want to separate all the main 
elements, but not every small object. 

For example, in this background, the main objects to be 
separated are:

Fern• 
Front tower• 
Second tower• 
Moon• 
Stars• 
Sky• 

However, some objects are not separated, such as the 
plants and the front tower or the roof and the second 
tower.

Also, each layer must be a complete drawing because 
even if the bottom of the tower is hidden behind the plant 
and the ladder, later on in the scene, the hidden portions 
may show up.

If you move a camera over a drawing, all the objects in the drawing move at the same speed. If you move the 
camera across the room, you will see all the objects are moving at different speeds, producing a depth effect.
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Build your backgrounds in Toon Boom Animate so that they are vector drawings. You can zoom as much 
as you want on vector drawings, but zooming a lot on bitmap images will result in pixelation.
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Setting the Multiplane Space
By default, all of your layers are set at the same distance. 
They are all located at “0”. You can see it better in the 
Perspective view. 

To open the 1. Perspective view, select  
Windows > Perspective.
In the Tools toolbar, select the 2. Rotate View  tool. 

The default keyboard shortcut is [Ctrl]+[Alt] for 
Windows or [z]+[Alt] for Mac.
In the 3. Perspective view, rotate the stage to view the 
3D space.

 

Use the default keyboard shortcut [Ctrl]+[Alt] in Windows or [z]+[Alt] in Mac OS to rotate the Perspective 
view.
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To set your multiplane space, you will use the Top view.

In the Top view, you can see the camera cone and all the 
layers set at the same distance.

To display the 1. Top view, select  
Windows > Top.
To display the Advanced Animation toolbar, select  2. 
Windows > Toolbars >Advanced Animation.
In the Advanced Animation toolbar, select the 3. 
Maintain Size  tool. This tool scales your layer as 

you move forward or backward in the Top view.
In the 4. Top view’s left side, select the layer you want 
to move.

In the 5. Top view’s right side, move the selected layer 
up to push it backward, or down to bring it forward. 
It is possible that you will not see the selected layer, 
but you can still move it.

The Maintain Size tool will scale your layer as you move it forward or backward and maintain the original look 
which you set in the Camera view. The depth effect will be visible once you move the camera.
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Animating the Camera
Since you will animate the camera over time, you will need 
to extend your layers’ exposure. The camera is a static 
element, to animate it you will need to add a trajectory 
layer called a Peg.

In the Timeline view, select the last frame of each 1. 
layer.

Press [F5] to extend the exposure until the end.2. 
In the Timeline toolbar, click on the 3. Add Layers  

button and in the drop-down list, select Camera.
In the Timeline view, select the Camera layer.4. 
In the Timeline toolbar, click on the  5. 
Add Peg  button.

You can animate the camera using the Translate  tool, 

Rotate  tool and Scale  tool available in the 

Advanced Animation toolbar.

To animate the Camera:
In the Tools toolbar, enable the Animate 1.  mode.

In the 2. Advanced Animation toolbar, select the 
Translate  tool.

In the Timeline view, go to the first frame.3. 
Select the Camera’s Peg and reposition it in the 4. Top 
view and Camera view.
In the Timeline view, go to the last frame.5. 
Select the Camera’s Peg and position it closer to the 6. 
background in the Top view and Camera view.

You can animate the camera in the Camera view by using the Translate tool available in the Advanced 
Animation toolbar.



7. In the Playback toolbar, click on the  
Play  button to view your animation.
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Adding lip-sync to a project can really enhance its 
quality and storytelling. But animating a lip-sync can 
often be tricky. In Toon Boom Animate there are many 
useful features available to help you complete this task 
quickly and efficiently. 

You can lip-sync the traditional way or let the system 
automatically create the basic detection.

You can use your own lip-sync ready cut-out character 
and sound file or use the ones provided to you in the 
sample material package.

The topics are: 
• Importing a Sound
• Decoding your Sound
• Assigning the Mouth Shapes
• Swapping Mouths
• Playing Back and Exporting
 
  * For Animate Pro, browse for Toon Boom Animate Pro 2 rather than Toon Boom Animate 2. 

The following sample material is located in the Animate 
Library of your operating system*:

Undone_example_Sample_material > • 
Chapter11_Sample_material.tpl
Mac•  
/Applications/Toon Boom Animate 2/
Templates/Samples/ SuperHero_Soundtracks
Windows XP•  
C:\Documents and Settings\All Users\
Documents\Toon Boom Animation\Toon Boom 
Animate 2\Templates\Samples\SuperHero_
Soundtracks
Windows Vista and 7•  
C:\Users\Public\Documents\Toon Boom 
Animation\Toon Boom Animate 2\Templates\
Samples\SuperHero_Soundtracks
 

Chapter 11 Sound and Lip-Sync
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Importing a Sound

The first step in lip-synching an animation is importing the 
dialogue into your scene. The dialogue is a sound file 
which only contains your character’s voice. It is important 
to only have the sound of the voice in this file as it will be 
the only sound which the lip-sync process will detect. In 
this example, the dialogue we will use is  
cartoon_monster-01.wav. 

Select 1. File > Import > Sound. 
In the Select Sound File browser, select your 2. sound 
file* and click on the OK button.

The sound layer will appear in the Timeline view and be 
displayed as a waveform. You can play your sound in the 
Timeline view and Sound Editor.

In the Timeline view, double-click on the sound layer 1. 
to open the Sound Editor.
In the Sound Editor, press on the 2. Play  button to 

listen to your sound.

* Refer to the previous page for the complete sample material paths.
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Decoding your Sound

A great way to determine the timing of the mouth 
animation is to use the Auto Lip-Sync Detection feature. It 
automatically detects each phoneme and assigns a mouth 
shape to it.

In the 1. Sound Editor, right-click (Windows) or 
[Ctrl]+Click (Mac OS X) in the Sound Element space 
and select Auto Lip-Sync Detection.
Press on the Play 2.  button to view the result in the 

preview space. 
An X mouth shape appears when no sound has been 

detected for a frame.

You can also detect your sound or fine tune the automated 
detection using the Sound Scrubbing feature. This feature 
lets you scroll through the character’s voice waveform in 
the Timeline view and listen to the sound one frame at a 
time.

In the Playback toolbar, click on the  1. 
Sound Scrubbing  button.

In the Timeline view, click and drag the red marker 2. 
to scroll through the scene and scrub the sound.

Read the Swapping Mouths topic to learn how to assign 
your mouth shapes as you decode your sound manually.

Refer to the Animate User Guide to learn more about the Auto Lip-Sync Detection and Sound Scrubbing 
features.
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Assigning the Mouth Shapes

The automatic 
detection supports 
seven sound mouth 
shapes and one 
silent mouth shape. 

Now it is time to assign the detected mouth shape to your 
actual character mouth shapes layer.

In the Timeline view’s 1. 
right side, right-click 
(Windows) or [Ctrl]+Click 
(Mac OS X) on the sound 
layer and select  
Lip-Sync > Map Lip-
Sync.
In the Mapping 2. Lip-Sync 
dialog box, choose the 
layer that contains your 
character’s mouths in the 
Destination Layer 
drop-down menu.
In the Mapping fields, 3. 
enter the name of each of 
your layer’s mouth shapes 
drawing. In this example, the actual drawing 
names, match the mouth shapes convention, so 
there is no need to change it.
Press on the OK button.4. 

The lip-sync timing is now all set in the Timeline view, in 
the mouth_shapes layer.
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Swapping Mouths
You can use the drawing swap feature to time your lip-sync 
from the start, or use it to quickly complete the 
Auto Lip-Sync Detection and Map Lip-Sync results.

In the Timeline view, click on the Expand 1.  button 

to display the Data view.

In the Timeline view, select the cell containing the 2. 
mouth shape you want to swap.
In the Data view space, place your cursor on top of 3. 
the drawing name until it changes to the swapping 
pointer, and choose the mouth shape you want to 
expose.

You can also use the Drawing Substitution panel to swap 
drawings.

In the Timeline view, select the cell containing the 1. 
mouth shape you want to swap.
In the 2. Library view, in the Drawing Substitution 
space, click and drag the slider to choose the 
desired mouth shape. This automatically swaps the 
current drawing for the one displayed in the preview 
window. You can also use the default keyboard 
shortcuts [ [ ] or [ ] ].

Refer to the Animate User Guide to learn more about swapping drawings.
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Playing Back and Exporting

Now it is time to playback the result and export the 
finished animation to a QuickTime movie file.

In the Playback toolbar, click on the 1. 
Enable Sound  button. This will let you hear the 

sound of your scene during playback.
In the Playback toolbar, click on the Play 2.  button 

and view your animation in the Camera view.

To export a QuickTime movie:
Select 1. File > Export > Movie.
In the 2. Export to QuickTime movie dialog box, click 
on the Browse button to name the movie and select 
where you want to save the file. 
Select either a specific frame range or the entire 3. 
animation to export.
You can also set the Video and Sound options as 4. 
required.
Click on the OK button to export your animation to 5. 
a QuickTime format.

Refer to the Animate User Guide to learn more about export options and parameters.
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Toon Boom Animate has more than one tool to help 
you animate efficiently. When doing hand-drawn 
animation, you will spend most of your time creating 
in-between drawings.

For a simple animation such as a flag, splashing water, 
smoke or even hair, you can use the Morphing feature 
to let the system automatically create 
the drawings 
between your keys!

You can create 
your own 
drawings or use a 
project from the 
sample material package.

The topics are: 
• Preparing Your Morphing Keys
• Creating the Morphing 

Sequences
• Adjusting the 

Ease

Chapter 12 Morphing a Flag
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Preparing Your Morphing Keys

1

2

3

The Morphing feature can be used to create computer 
generated drawings between simple shapes. Your 
drawings can have outlines or not. It is up to you! 

Your key drawings have to follow these basic rules: 
Drawings must be painted with the same colour • 
swatches. 
Drawings must have the same number of zones.  • 
If a colour zone does not exist in one of the two key 
drawings, it will progressively appear or vanish.
Drawings must be flattened.• 
A contour line (fill) must be morphed with a • 
contour line, and a centre line (pencil) must be 
morphed with a pencil line.
You can have several colours in a morphing key.• 
You cannot morph colour tints.• 

To create your first morphing sequence, try using simple 
shapes without an outline. Once you master the feature, 
you can experiment as much as you want.

When you animate effects such as smoke, think of using the Morphing feature to create your in-betweens. It 
has the advantage of being reusable and you can change the timing to create longer or shorter animations.
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1 2 3 1

To morph the flag, first draw three keyposes and set their 
approximate timing. Note, once your morphing sequence 
is done you can always increase or decrease your timing. 

We added a flagpole layer. You can do the same. 
In the Timeline view, add a drawing layer and name 1. 
it “Flag”.
In the Tools toolbar, select the 2. Brush  tool.

In the Colour view, select a solid colour.3. 
In the Camera view, draw your first flag.4. 
In the Tools toolbar, select the 5. Paint  tool and 

paint your flag using the same colour.
In the Tools toolbar, select the 6. Select  tool.

In the Camera view, select your entire flag.7. 
In the Tools Properties view, click on the 8. Flatten  

button.
Repeat the same steps for the two other flag 9. 
drawings. Create your drawings on frames 10 and 
20.

Once your are done creating your key drawings, you can 
transform your solid colour into a gradient to make the flag 
even more interesting. You can then add several gradient 
arrows to simulate highlights and shadows.

From the Tools toolbar, use the Edit Gradient/Texture  

tool to reposition your gradient zones the way you want.

Copy your first key drawing and paste it at frame 30.10. 

If you set two different gradient positions on your key drawings with the Edit Gradient/Texture tool the 
position will be interpolated during the morphing sequence.
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Creating the Morphing Sequences

You are now ready to create your first morphing sequence! 
In the Timeline view, select your first key drawing.1. 
Right-click (Windows) or [Ctrl] + click (Mac OS) and 2. 
select Morphing > Create Morphing.
Repeat the process for each key drawing.3. 

You now have three morphing sequence.
In the Playback toolbar, press the 4. Play  button to 

see the result.

As you probably noticed, there are in-between drawings, 
but they are not necessarily going the way you want. Your 
flag probably looks like a piece of cardboard bending 
instead of smoothly flapping in the wind. Also, it is most 
likely that you will have strange corners and points.

All that is because the system is always looking for the 
closest similar line, corner or curve to morph the drawing.

To fix random 
results like this 
one, you will place 
morphing hints 
along the flag’s 
contours. 

To fix a morphing sequence, you need to control its 
behaviour with Morphing Hint points. Hint points associate 
areas from the key drawings together so that the system 
knows how to control the drawings. 

You can control different aspects of your animation. Here, 
we will focus on controlling the contour using Contour Hint 
points. 

When fixing a morphing sequence, you will add points all 
across the screen. This is done progressively. To fix the 
flag, will take you three passes:

Blocking the corners• 
Animating the wind waves• 
Fixing the remaining details• 

The Hint points tell the system how to animate your drawings. It is almost like telling your assistant animator 
what to do.
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When you add points on the corners and tips, you will see 
that most of the shape problems are resolved. Fixing one 
big problem will often fix all the small ones.

In the Tools toolbar, select the 1. Morphing  tool.

In the Timeline view, select the first key drawing.2. 
In the 3. Tool Properties, select the Contour Hint  

option.
In the Camera view, click in the screen to add a new 4. 
Contour hint.
Select the hint point and drag it toward the flag’s 5. 
contour until it snaps.
Position the hint on a corner to lock it in place.6. 
Repeat these steps for all of the corners.7. 
Press 8. [F4] to switch to the other key drawing.

 Select the existing hint points and snap them to the 9. 
corresponding corners.

In the first and second key drawings, associate the 10. 
wind waves so that it will slide to the right instead of 
up and down.

After fixing the corners and waves, there should only be a 
few details left to fix.

Set your hint points on the other morphing 11. 
sequence in the same way you did for the first one.

A morphing sequence is composed of two drawings. If you have more than one morphing sequence, you will 
need to set hint points for each sequence. If a drawing is used in two sequence, it will have two sets of hints.
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This hint point associates these 
two waves together. It makes the 
wave slide from left to right 
instead of going up and down as 
it was originally doing.

This hint point associates these 
two corners together and locks 
the flag’s corner on the spot 
instead of having it wrap around.

First set your hint points in the corners and intersections. Use the many types of hint points to control 
different aspects of your morphing sequence. Refer to the Animate User Guide to find out more.
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Adjusting the Ease

1 23 4 5 6

Once your morphing sequence is completed, you can 
adjust the ease so that your animation does not look too 
mechanical.

In the Tools toolbar, select the 1. Morphing  tool.

In the Timeline view, select the first key drawing.2. 
In the 3. Tool Properties view, set the Ease In and Ease 
Out values by clicking on the Increase and Decrease 
arrows.

You are now ready to explore the Morphing capabilities!

If you are morphing a drawing with holes, such as a donut, you need to enable the Flatten option in the 
Morphing tool’s Tool Properties view.
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In Toon Boom Animate, there are many effects you can 
easily use to improve the quality of a project. 

In this chapter you will use two of these effects in a 
production-like context to enhance your scene. 

You can practice these effects on material you create 
from scratch or you can also use the sample material:

Undone_example_Sample_material > • 
Chapter13_Sample_material.tpl

The topics are: 
• Painting a Starry Sky
• Making your Stars Glow
• Fading your Stars
• Lighting Up the Lampposts
• Making it Shine in the Night
• Keeping Your Distance
• Preparing to Hit the Switch
• Hitting the Switch
• Shooting Star
• Putting On a Mask
• Editing the Mask

Chapter 13 Creating Effects (Animate Only)

This chapter does NOT apply to Animate Pro. Refer to the Animate Pro Getting Started Guide to learn how to 
create effects in Animate Pro, using the exclusive Network view.
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Painting a Starry Sky

To build a starry night effect, we first need a layer of stars. 
In Animate, select a star-shaped brush, pick a star-like 
colour, and draw stars on a new drawing layer! 

In the Timeline view, click on the 1. Add Layers  

button to add a Drawing layer on top of your 
background.
Name the new layer 2. Stars and click on its first cell.
In the Tools toolbar, select the 3. Brush  tool.

In the 4. Tool Properties view, select a star shaped tip  
and customize the minimum and maximum size 
values so that you have a range of star sizes when 
you draw with your pen tablet.

In the Colour view, pick a star-like colour.5. 
In the Camera view, draw your stars.6. 

Refer to the Animate User Guide to learn more about the Tools Properties.
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Making your Stars Glow

Now that you have stars in your project, it is time to make 
them shine! 

As you customize your effects, you can preview the final 
result in the Camera view.

In the Camera view bottom toolbar, click on the 1. 
Render  mode button.

To update the preview, click on the 2. Update Preview 
 button. 

To make your stars glow:
In the Timeline view, right-click (Windows) or 1. 
[Ctrl]+Click (Mac OS X) on the Stars layer and select 
Duplicate Selected Elements. 
Rename the new layer 2. Stars_Matte.
Click on the 3. Add Layers  button and select 

Effect > Glow.
Click and drag the 4. 
Star_Matte layer on 
the Glow effect 
layer.

In the Timeline view, double-click on the Glow layer 5. 
to display the Layer Properties dialog box.

Set the 6. Blur Radius value.
Pick a colour and alpha value. Double-click on the 7. 
colour swatch to display the Colour Picker. 

You can enable the Auto Render preview option by clicking and holding the Update preview button in the 
Camera view bottom toolbar and selecting Auto Render.
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Fading your Stars

Now that your sky is glowing with stars, you might want to 
soften them a bit. Try adding a Transparency effect on your 
Star layer. 

In the Timeline view, click on the Add Layers 1.  

button and select Effect > Transparency.

In the Timeline view, click and drag the Stars layer 2. 
on the Transparency effect layer to connect it.

In the Timeline view, double-click on the 3. 
Transparency layer to modify the transparency value 
of your layer.

Display the result in the Camera view using the 4. 
Render mode. 
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Lighting Up the Lampposts

Lighting up the lampposts is as easy as making the stars 
shine. But first, you have to create a lamp layer from the 
background layer.

In the Timeline view, select the Bg layer’s first cell.1. 
In the Tools toolbar, select the 2. Select  tool.

In the Camera view, make sure that you are in Open 3. 
GL  mode and select the light bulb zones of the 
two lampposts. Press [Shift]+Click as you select the 
zones to create a multi-selection.
Press the default keyboard shortcut [F9] (Windows) 4. 
or [z]+[F9] (Mac OS X) to Create Drawing from 
Drawing Selection. 
Name your new layer 5. light_matte.
In the Timeline view toolbar, use the Add Layers 6.  

button to create a new glow effect layer.
In the Timeline view, connect the light_matte layer 7. 
under the glow layer and customize the effect.
Verify the result in the Camera view, using the 8. 
Render  mode.

You can make a multi-selection using the [Shift] key while clicking on your objects in the Camera and Drawing 
view using the Select tool.
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Making it Shine in the Night

Adding a halo around the lampposts and a highlight on 
the statue is an easy and effective way to enhance the 
glow effect and integrate all of the elements in the scene.

In the Timeline view toolbar, use the Add Layers 1.  

button to create a new drawing layer.
Name this new layer2.  Lamp_Highlight_matte.
In the Timeline view, select the first cell of the new 3. 
layer.
In the Tools toolbar, select the 4. Ellipse  tool.

In the Tool Properties view, enable the 5. Auto Fill  

mode.
In the Colour view, select any colour.6. 
In the Camera view, trace a large ellipse around the 7. 
lamp area. This shape will become your halo.
In the Timeline view, click on the Add Layers 8.  

button and select Effect > Highlight. 

Refer to the Animate User Guide to learn more about the different effects available in 
Toon Boom Animate.
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The Highlight layer, unlike the Glow effect, will only affect 
particular layers. This means you need to connect the mask 
as well as the layer it will affect. In this case, it will be the 
Bg layer. 

In the Timeline view, click and drag the Lamp_1. 
Highlight_matte layer on to the Mask of the 
Highlight effect layer and click and drag the bg layer 
onto the Highlight.
As with the Glow effects, in the Timeline view, 2. 
double-click on the Highlight layer to customize it.
In the Camera view, verify the result using the 3. 
Render  mode.

The statue highlight effect will follow similar steps.
In the Timeline view toolbar, use the Add Layers 1.  

button to create a new drawing layer.
Name this new layer 2. Statue_Highlight_matte.
In the Timeline view, select the first cell of the new 3. 
layer.

In the Tools toolbar, select the 4. 
Brush  tool.

In the Camera view, paint 5. 
the highlight zones.
In the Timeline view, click on 6. 
the Add Layers  button 

and select Effect > 
Highlight.
In the Timeline view, 7. 
click and drag the 
Statue_Highlight_matte 
layer on to the Mask of the 
Highlight effect layer and 
click and drag the Statue layer 
onto the Highlight.
In the Timeline view, double-8. 
click on the Highlight layer to 
customize it.
In the Camera view, verify the result 9. 
using the Render  mode.

When painting a highlight zone, you do not need to worry about other layers as the highlight effect will only 
affect the layer you decide to connect into it.
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Keeping Your Distance

A good way to increase a depth illusion is by having an 
overlay which is out-of-focus. In this example we will be 
hiding behind a broken structure.

In the Timeline view toolbar, click on the Add Layers 1. 
 button and select Effect > Blur.

In the Timeline view, click and drag the Ol layer onto 2. 
the Blur effect layer.

In the Timeline view, double click on the Blur layer to 3. 
customize the Radius value of the effect.

In the Camera view, verify the result using the 4. 
Render  mode.
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Preparing to Hit the Switch

All these effects can be animated over time. For this 
example, we will progressively light up the lampposts 
making their glow, halo and the statue’s highlight 
gradually appear. Now, let us prepare this nice effect.

In the Timeline view, use the Add Layers 1.  button 

to add three Transparency effect layers.
In the Timeline view, connect the lamppost’s Glow 2. 
layer into one of the Transparency layers.
Connect the matte shape layers of the two Highlight 3. 
effects into the two remaining Transparency layers. 

With these Transparency layers you will create a fade in 
effect, making the scene go from lights out to lights on. 
Now we need to extend the scene so that we can animate 
the effects.

In the Timeline view, make a multi-selection of all of 1. 
your layers’ last cell of the scene using [Shift]+Click.
Press [F5] to extend the exposure.2. 

Refer to the Animate User Guide to learn more about keyframes and functions.
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Hitting the Switch

Now is the time to create a function and enter the 
keyframes that will animate the Transparency effects and 
gradually light up your scene. 

1. In the Timeline view, click on the Expand  button 

to display the Data view.

In the Timeline view, click on the Transparency layer 2. 
Expand  button to display the Transparency’s 

function.

Make sure that your timeline marker is on the first 3. 
cell, click on the Add Keyframe  button and enter 

the first Transparency value. This keyframe should 
be set to 100 so that the lights are out.

You can create a hold at the start and end of your scene by adding two more keyframes on your timeline. One 
of equal value to the first one of your scene and another one of equal value of the one at the end.
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4. Move the timeline marker to the last frame of your 
scene and press the Add Keyframe  button and 

enter the last transparency value. This value should 
be set to 0 (zero) to light up the scene completely.

Repeat 5. Step 1 to Step 4 for the other two  
Transparency layers.

Follow these simple steps to preview your animated effect.

 
In the Playback toolbar, click on the 1. 
Render and Play  button.

Your frames will be calculated and the Play view 
will pop up.

In the Play view, press on the 2. Play  button and 

enjoy your scene!

Refer to the Animate User Guide to learn more about the Play view and previewing your scene as well as 
exporting your scene.
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Shooting Star

Now, to make things more interesting, let’s add a shooting 
star flying across the heavens. Use the collapsed layer 
Shooting_Star which we have provided.

In the Timeline view, enable the  X
Shooting_Star layer and drag it between the 
bg and the statue layers.

A

B

To animate the shooting star:
In the Tools toolbar, click on the 1. Animate  button 

and then click on the Transform  Tool button.

In the Timeline view, click on the first cell of the 2. 
Shooting_Star layer.
In the Camera view, click and drag the shooting star 3. 
to its first position on the extreme left, outside of 
the camera frame.
In the Timeline view, click on the last cell of the 4. 
Shooting_Star layer.
In the Camera view, click and drag the shooting star 5. 
across the screen, ending at it’s final position.

The system will automatically create the motion between 
the two keyframe positions.
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The shooting star now moves at a constant speed along 
the straight line from point A to point B. To add a curve 
and a velocity effect, follow these steps.

To add a curve to the animation:
In the Timeline view, select the Shooting_Star layer.1. 
Select 2. View > Show > Control to display the 
trajectory.
In the Camera view, position your cursor over the 3. 
trajectory and press [P] to add a control point.
In the Camera view, click and drag the new control 4. 
point to create a curve.

In the 5. Coordinate and Control Point view, adjust the 
Tension and Continuity values to adjust your 
trajectory’s curve.

To add a velocity effect.
In the Timeline view, click on the Expand 1.  button 

to display the Data view.
In the Timeline view, click on the Expand Arrow 2.  

and Expand  buttons of the Shooting_Star layer 

to display its functions.

In the Timeline view, double-click on the Offset 3. 
Velocity function of the shooting star layer.

The Velocity Editor dialog box opens.

In the Velocity Editor dialog box, click on the last 4. 
keyframe and drag the handle toward the centre to 
create a velocity curve.

By default, the preferences are set to Motion Keyframes, this means that the system will automatically create 
the motion between the two keyframes of the shooting star.
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Putting On a Mask

Now the shooting star is all set, only one thing is left to do. 
Since the lampposts are part of the bg layer, the star 
cannot pass behind them. For this reason, we will add a 
mask layer and drawing that will hide the shooting star 
when it passes in front of the lampposts, giving the illusion 
of passing behind. For this lesson, a matte drawing of the 
lampposts is provided for you. 

In the Timeline view, enable the Lamp_Mask layer 1. 
and drag it on top of the Shooting_Star layer.

 

In the Timeline view toolbar, click on the Add Layers 2. 
 button and select Mask.

In the Timeline view, drag the Lamp_Mask layer 3. 
onto the Mask’s matte layer to connect it to it.

In the Timeline view, connect your Shooting_Star 4. 
layer under the Mask top layer.

The shooting star will now cross the screen behind the two 
lampposts!

Refer to the Animate User Guide to learn more about Trajectories, Control Points and the Velocity Editor.
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Editing the Mask

Once a matte drawing layer is connected to a mask effect 
the drawing will become invisible in the Camera view, as it 
will automatically be applied as a mask. If you need to edit 
your matte drawing after you create your connections in 
the Timeline view, you can easily make your drawing visible 
without breaking the connections. 

In the Timeline view, select the Mask Effect layer.1. 

Select 2. View > Show > Control. 
This will automatically render your drawing visible 
in the Camera view. It will be displayed on top of 
all other layers, making the editing easy to do.

In the Tools toolbar, select the drawing tools you 3. 
need.
In the Camera view, edit your matte drawing.4. 
Select 5. View > Show > Control to hide the matte 
drawing and return to the normal display of your 
scene.

Refer to the Animate User Guide to learn more about Mask and Effects.
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The Toon Boom Animate Pro Starting Guide guide builds on the 
content included in the Toon Boom Animate Starting Guide. This 
guide contains supplementary information about 
Toon Boom Animate Pro’s specific features. Together, they form the 
absolute kick start guide, covering all the basics of this software that 
you need to get started on your own projects with 
Animate Pro.

Before starting these lessons, it is highly recommended that 
you complete the lessons in the Toon Boom Animate Getting 
Starting Guide first.

Discover the basics of Animate Pro’s key features through 
three new lessons. Use the sample material provided or if 
you prefer, use your own. The sample material will help you 
follow the different exercises contained in this guide.

To install the sample material provided, simply follow the 
installation instructions at the end of this chapter:

• Sample material setup guide

 or download them from our website at:
toonboom.com/products/animatepro/eLearning• /

The keyboard shortcuts used in this guide are based on the 
Adobe®Flash® shortcut set.

Get ready to Animate Pro!

 IntroductionChapter 1 

http://www.toonboom.com/products/animatepro/eLearning/
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Refer to Toon Boom Animate Getting Started Guide to obtain the complete Training Outline.

Your Training Outline
Get ready!  Let’s take a first glance at this Starting Guide’s training 
outline.

Chapter 2 From Sketching Table to Animate Pro
Learn the different ways to add and use textures  in your project, 
an easy way to enhance its look and quality.

Chapter 3 Going 3D
Unleash Animate’s power by creating a full 3D decor. Rotate your 
layers on all axis and get your camera to pivot on a 360 degree 
trajectory.

Chapter 4 Building a Cut-out Puppet Using the 
Network View
Learn how you can easily take your cut-out puppet and rig it inside 
the Network view.

Chapter 5 Compositing
Learn how to use the Network view to enhance the quality of your 
projects by compositing effects from the effect modules contained 
in the Module Library view.
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What’s Extra in Animate Pro?
Animate Pro is the professional version of Toon Boom Animate.  In Animate Pro you will find many exciting and powerful 
new tools as well as all the features from Animate, making your life even easier and allowing you to create with style!

These are an highlight of the top features you will find in Animate Pro :

•	 Advanced Compositing 
Using the Network and Module Library views, you 
can create complex effects and advanced puppet 
rigging.

• Line Texture 
Using the Brush tool, you can sketch and design 
with textured brush styles. You can even create 
your own pencil-bank by creating a set of bitmap 
textures in a third-party software.

• Advanced Traditional Animation Features 
Using features such as Multiple Drawing Layers 
and Annotation Columns, you can complete your 
hand-drawn animations with ease while feeling at 
home with tools you are familiar with. 

•	 Full 3D Rotation 
You can enable the 3D rotation on your elements 
and camera to pivot them on all 3 axis, creating a 
3D set where you can animate your characters and 
amazing camera moves. 
More Effects •	
You can find many more effects in the Module 
Library, such as the Refract, Glue and Sparkle.

• Multiple Renders 
Because of its Network view and node system, 
Animate Pro allows you to render out different 
resolution, formats and portions of your scenes 
simultaneously.

Refer to Toon Boom Animate Getting Started Guide to learn more about Interface Highlights.
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Refer to Toon Boom Animate User Guide to learn more about the Network view.

Network View Legend
The Network view is the main view used to composite the 
scene’s components, special effects and rig cut-out 
characters.

Refer to the following legend to learn about the Network 
view.

Note: The numbers in this legend correspond to the 
numbers in the Network view on the following page.

Network Main View:1. 
This is where you drag in, organize and connect the 
different modules in your scene.
Main Modules:2. 

•  Drawing Layer

•  Effect

•  Display

•  Write

•  Peg

•  Composite

3. Module In and Out Ports:

In port

Out port

The input and output ports are used to connect 
modules. Simply click and drag one port to another 
port and  a connection is created.
Navigator: 4. 
This is a smaller version of your Network view. Use 
this to zoom in, zoom out and pan to navigate 
through your network.

Note that  because they are created using the 
Timeline view, effects previously created using 
Animate will be displayed as orange group modules 
when in Animate Pro. This way it is easy to quickly 
identify them.
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Sample material setup guide
Templates and sample files will be required for some of the 
lessons in the Getting Started Guide. You must first install 
them, then follow steps to use them in your project.

Step-by-step installation
Go to the following web page: 1. 
toonboom.com/products/animatepro/eLearning/
In the Tutorials section download the Sample 2. 
Material package.
Once the package is downloaded, double-click on it 3. 
to launch it.
Follow the installer’s instructions.4. 

To use the templates
To use the templates:

Launch Toon Boom Animate Pro.1. 
Create a new blank project.2. 
In the Library view, click on one of the following 3. 
folders to view the sample material content:

Templates X
Templates > Undone_example_Sample_ X
material
Templates > Completed_examples X

Select a template from the right-hand side of the 4. 
Library view.
Click and drag that template to the left-hand side of 5. 
the Timeline view and drop it where the layers are 
ordered. You can also drop it directly in the Camera 
view.

The template now appears in both the Timeline 
and Camera views and is ready to be animated!

http://www.toonboom.com/products/animatepro/eLearning/
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Files in the Library view
Here are the types of files you will find in the templates 
folder:

Undone_example_Sample_material• 
Prepared scenes to be completed during 
lessons in the Getting Started Guide.

Completed_examples• 
The resulting scene files for completed 
lessons in the Getting Started Guide.

Templates• 
Various elements that can be used to 
completed some of the lessons in the 
Getting Started Guide.

Extra sample material
You will need to browse and import some extra files from 
the following location:

Mac•	 : /Applications/Toon Boom Animate Pro 2/
Templates/Samples
Windows XP•	 : C:\Documents and Settings\All 
Users\Documents\Toon Boom Animation\Toon 
Boom Animate Pro 2\Templates\Samples 
Windows Vista and 7•	 : C:\Users\Public\
Documents\Toon Boom Animation\Toon Boom 
Animate Pro 2\Templates\Samples

Files for Animate chapters 3, 5 and 11:
background_tv.psd• 
SuperHero_Soundtracks (3 sound clips)• 
Textures (16 examples)• 

Files for Animate Pro chapter 2:
Multi-layerd_Monster.psd• 
monster_drawing.png• 





Are you a pencil and paper lover? Animate Pro lets you 
scan and import your sketches, draw directly in the 
application using textured lines, bring in your colourful 
illustrations and keep your bitmap colours as well as fully 
vectorizing your cleaned up drawings.

You can play around with textures, vector and bitmap graphics to 
get the high quality look you are wishing for.

To go through this lesson, you can use the bitmap images provided 
in the sample material package or scan your own sketches. You will 
also find a full page illustration to scan included in this chapter.

In the provided sample material, you can find the 
monster_drawing.png and the Multi-layered_Monster.psd in the 
following folder:

Mac•	 : /Applications/Toon Boom Animate Pro 2/
Templates/Samples
Windows XP•	 : C:\Documents and Settings\All Users\
Documents\Toon Boom Animation\Toon Boom 
Animate Pro 2\Templates\Samples 
Windows Vista and 7•	 : C:\Users\Public\Documents\
Toon Boom Animation\Toon Boom Animate Pro 2\
Templates\Samples

The Topics are:
• Monster Scanning
• Scanning Process
• Pencils and Crayons in Animate Pro
• Colours as Textures

Chapter 2  From Sketching Table 
to Animate Pro

 11
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Once a TWAIN scanner is installed on your computer, Animate Pro will detect it automatically and add it to the 
TWAIN Source list.

Monster Scanning
One of the first techniques you can use to get your 
drawings into Animate Pro is to scan them using a TWAIN 
device. You can adjust the import settings to match the 
style you are looking for.

Follow these main steps to get your sketches into 
Animate Pro:

Make sure a TWAIN device is installed on your • 
computer and working correctly.
In Animate Pro, create a new project or open the • 
scene where you want to import your artwork.
Scan your drawings.• 
Set the vectorization parameters.• 
Import your images.• 

You can scan the monster drawing included on the 
following page and follow the next steps in this lesson. 
(We have also included a digital version of this image in the 
sample material package). Or you can scan one of your 
own designs, try to find a drawing with a few rough lines 
where you see the pencil texture.
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Refer to the Toon Boom Animate User Guide to learn how to create your own vectorization parameter presets.

Scanning Process
To scan your drawings, make sure your scanner is 
connected and you are ready to go!

To scan your drawings:
In the Top Menu, select 1. File > Import > From 
Scanner.

The Scan Drawings dialog box opens.
In the Scanner section, select your scanner from the 2. 
list
Click on the Scan button to begin the scanning 3. 
process using the scanner’s interface.

2

3

5

7

8

6
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In the Scan Drawings interface, you can click on the Show Scanner Album button to return to the Scanner 
Album window.

Once the scan is completed, the Scanner Album 4. 
opens to let you organize the scanned images.
In the Scan Drawings window, enable the Create 5. 
Layer(s) option and name your new layer in the 
Name field.
Make sure the Vectorize Imported Items option is 6. 
enabled. You can also disable the Create Symbol for 
the Imported Items option if you do not want the 
new layer to be encapsulated in a Symbol.
To keep the pencil line’s texture, select the Grey 7. 
default vectorization parameters.
Click on the OK button and let the system import 8. 
and vectorize your images. This is the greyscale vectorization result in Animate Pro.
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When you import a bitmap image as a pen texture, the colour in the image is not used. The Brush tool will use the 
colour selected in the Colour view.

Pencils and Crayons in Animate Pro

You do not necessarily need a scanner in Animate Pro to 
play with texture. In fact, you can create your own set of 
textured pens and draw with them directly in the 
application.

These pens can be used to either correct imported 
sketches or to draw artwork from scratch, straight in the 
Camera view.

Animate Pro supplies you with a series of default texture 
brushes or you can create your own in a third-party 
software and then import them in the Tool Properties view.

The only requirement is that the image used as your 
texture must be in either PSD or TGA file format.

To use a textured brush:
In the Tools toolbar, select the Brush 1.  tool.

2. In the Tool Properties View, display the Brush 
drop-down list and select one of the default 
textured brushes.
In the Camera view, start drawing.3. 
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In the Eraser Tool Properties view, you can enable the Use Blur Parameters option to create a feather when 
erasing a textured line instead of having a straight cut.

If you have a texture such as this and you 
would like to use it to draw in 
Animate Pro, you can simply import it 
into your brush list and use it as a default 
texture.

To import a texture in your brush list:
In the Tools toolbar, select the Brush 1.  tool.
In the Tool Properties view, click on the Add Pen 2. 
button.
Check the Enable Texture option.3. 
Click on the Texture button to browse and select the 4. 
desired bitmap image. The image has to be a PSD 
or a TGA file format.
In the Camera view, start drawing.5. 
In the Tool Properties view, adjust the opacity, 6. 
hardness and texture size parameters.

In the Sample material, you can use the monster structure 
template provided to trace your own character over or you 
can sketch your own.
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When creating bitmap pieces for a puppet in a third-party software, it is a good idea to create a feathered edge on 
the articulations. This way, when you animate the puppet, the joints look much neater.

Colours as Textures
If you created illustrations and drawing pieces in a third-
party software such as Adobe® Photoshop®, you have two 
options available when you import these images in 
Animate Pro. You can either import them as bitmap images 
or vectorize them using the Colour as Texture option.

If your image is to be used as a background or an overlay, 
there is no need to vectorize them. Although, if you are 
planning on building a photo puppet or using 
Animate Pro’s drawing tools to modify the imported 
artwork, vectorizing your images using the Colour as 
Texture parameters will be quite useful.

Note: your image will remain a bitmap, but it will be 
contained in a vector frame. This way, you can modify the 
contours using the Contour Editor tool or draw over with 
the Brush tool or even erase areas.

In the Sample Material package, you can find a complete 
image of the same monster character as well as a multi-
layered PSD file containing its body divided into five main 
pieces. You can use those to try out the colour 
vectorization.

Once the pieces are imported, you can move on to the 
next lesson to learn how you can connect them.
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The	Transparency	type	of	the	imported	image	is	related	to	how	the	alpha	channel	in	the	source	file	was	
pre-multiplied with the background. Refer to the Toon Boom Animate User Guide to learn more about this.

1. In the top menu, select File > Import > Images.
2. In the Import Drawings dialog box, click on the 

Browse button and select the images to import.
Enable the Create Layer(s) and the Create Layer(s) 3. 
Based on Filename options to make a new layer with 
the same name as your file.
Make sure the Vectorize Imported Items  and the 4. 
Create Symbol for Imported Items options are 
enabled.
In the Vectorization area, select the Colour option.5. 
Click on the OK button.6. 

7. If your image is a multi-layer PSD file, the Multilayer 
Image Import Settings dialog box opens.

Select the All Layer Images option and set the 8. 
Transparency type to match the source file.
Click on the OK button and let the system import 9. 
and vectorize your images.

2

3

4
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Toon Boom’s technology has always been recognized for 
its Multiplane feature. Now you can take this attribute one 
step further by going 3D! 

Learn how to build sets by rotating and repositioning 
planes in three dimensional space. Apply textures, 
patterns and gradients and see them mapped in 
perspective onto your drawing objects.  Discover how to 
use a camera to explore the 3D area, including the use of 
fully rotational pivots, as well as how to give the illusion of 
3D by panning a multi-plane’s layers.

You can practice this chapter on material you create from 
scratch or you can also use the sample material.

Undone_example_Sample_material > • 
Chapter3PRO_Sample_Material.tpl    

The topics are:
• Setting Up Your Workspace
• Building the Structure
• Filming Your Set
• Adding an Outdoor 

Decor

Chapter 3  Going 3D
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When you position elements in the 3D space, it is important to remember that your drawings are still 2D images. If 
you	rotate	the	camera	around	them,	they	will	still	look	like	flat	layers.

Setting Up Your Workspace
 

You might be concerned that thinking in a 3D  mindset will 
be complicated.  Never fear!  In this lesson, we will take 
you step by step on how to construct in and move through 
this new frontier.

When you open the sample scene and look at it in the 
Perspective view, it will look like the picture above, with all 
the layers flattened on the same x, y, z planes.  

In the Timeline view, take a moment to examine the layers 
and to get an idea of what kind of movements you might 
need to make to separate them.

It will occur to you that the floor, ceiling, left and right walls 
need to rotate outwards at a 90 degree angle from the 
Back_Wall.
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Animate Pro allows you to build very complex 3D sets. You could build an entire fortress or a spaceship as 
long as you plan out your different walls and pieces and reuse them in your different scenes.

To perform these operations, you will need the following 
views:

• Layer Properties View
Perspective View• 

• Top View
• Side View

In the top menu, select   X
Window > the desired window.

In the Layers Properties view, you will be able to set the 
position coordinates and enable the 3D movements.

The Side view allows you to see your scene’s elements 
from the side and move them on the Y-axis and Z-axis.

The Top view allows you to see your scene’s elements from 
the top and move them on the X-axis and Z-axis.
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If you are unsure of what the width and height of your drawings should be, you can always go back in the Drawing 
view after the setup is done and correct your drawing to match the layout better.

Building the Structure

At this point, you should have all the layers necessary to 
build your 3D set. In this case, we have three walls, a 
ceiling and a floor. Later on, we will also include an 
outdoor background to see through the window.

By default, the 3D motions are disabled on your drawing 
layers, this prevents you from accidentally rotating them 
when you need your drawings to stay perfectly flat and 
aligned with the camera. So, when you want to rotate 
layers in the 3D space, you need to enable the 3D motions.

To enable the 3D motions:

In the Timeline view, select the layer you want to 1. 
enable the 3D motion for.
In the Layer Properties view, check the 2. Enable 3D 
option.

You will notice a series of changes in the Layer Properties 
view, mainly regarding the Rotation section. You now have 
the Quaternion and the Euler Angles options.
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When you build a 3D room, make the walls wider or higher than they need to be for your drawings to 
intersect in the corner and avoid having small gaps.

There is a substantial difference between the Quaternion 
and Euler Angles options. They will not be covered in this 
guide. Refer to the Animate User Guide to learn more 
about those.

To give you a basic idea, you will mainly use the 
Quaternion rotation when you want to create a smooth 
trajectory over the three axes, such as a camera move, and 
you will use the Euler Angles when you have a precise 
position in mind for a stationary object such as a wall.

To build our room structure, we will use the Euler Angles 
rotation.

To	position	the	floor:
In the Timeline view, select the Floor layer.1. 
In the Layer Properties view, check the 2. Enable 3D 
option.
In the Rotation section, enable the 3. Euler Angles 
option.
In the (x) Axis field, type -90 to give the backward 4. 
rotation to the floor.
In the Position section, enable the Separate option 5. 
to control the three axis separately.
In the (y) Axis field, type -12.25 to send the floor to 6. 
the ground.

Rotation 
(x) Axis: -90

Position 
(y) Axis: -12.25

Repeat the same process for the back wall, ceiling and side 
walls.

Back Wall: Position (z) Axis = -4.55

Left Side Wall: Position (x) Axis = -12.3, (z) Axis = -1.55, 
Rotation (y) Axis = -90

Right Side Wall: Position (x) Axis = 12.3, (z) Axis = -1.55, 
Rotation (y) Axis = 90

Ceiling: Position (y) Axis = 12.25, Rotation (x) Axis = 90
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To animate a camera motion, selecting the Quaternion rotation is your best choice if you want to have a very smooth 
and well interpolated trajectory.

Filming Your Set

Now is the really exciting part: adding a camera and 
filming on a 3D trajectory!

To do so, you will need to add a Peg to your camera and 
set the trajectory, the same as the camera rail used in 
live-action shooting.

To animate a 3D camera move:

In the top menu, select 1. Insert > Camera.
In the Timeline view, select the Camera layer.2. 
In the Timeline toolbar, click on the Add Peg 3.  
button to parent a peg layer to your camera.
Select the Camera Peg layer.4. 
In the Layer Properties view, check the 5. Enable 3D 
option.
In the Rotation section, enable the 6. Quaternion 
option.

In the top menu, select 7. Window > Toolbars > 
Advanced Animation to display the Advanced 
Animation toolbar.
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The Advanced Animation toolbar is useful to set your camera since it allows you to control one movement 
type at a time. You can use the Rotate tool to set your angle, then the Translate tool to set your position.

In the Timeline view, go to the first frame.8. 
In the Tools toolbar, enable the 9. Animate  Mode.
In the Advanced Animation toolbar, select the 10. 
Rotate  tool or the Translate  tool.

In the Camera, 11. Top and Side views, set your 
camera’s first position.

In the Timeline view, go to the last frame.12. 

In the Camera, Top and Side views, set your 13. 
camera’s last position.
If you do not have interpolation between your 14. 
frames, select the camera’s first keyframe and use 
the Set Motion Keyframe shortcut [Ctrl] + [K] 
(Windows) or [z] + [K] (Mac OS X).
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Encapsulating your multiplane background in a Symbol is a great  idea for keeping your Timeline view clear and 
organized. This way, you only get one layer instead of several ones added to your scene.

Adding an Outdoor Decor

To enhance the look of your scene, include what you 
previously learned about the multiplane. 

When your camera is moving, having a multiplane 
background outside the window will add that little 
something special to your scene.

You will find in the Symbol library of your sample scene a 
multiplane background that you can import in your 
Timeline view’s left side.
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Refer to the Animate User Guide to learn more about adding props and other elements to your scene as well 
as locking some layers to the camera.

In the Playback toolbar, 1. 
click on the Play  
button to playback your 
scene.
Adjust your camera 2. 
move to get the look 
you want. 

You can start adding more 
elements to your scene such 
as props in the room or effects 
on your layers.

Once you are comfortable 
with the 3D scene setup, you 
can start building houses, 
buildings and beyond!
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Chapter 4  Building a Cut-out Puppet Using the Network View
In Toon Boom Animate Pro you will find all the tools, 
features and views you ever wished for to build cut-out 
puppets and animate them. A wide variety of breakdown 
and rigging techniques are available since 
Animate Pro mixes the most common and popular 
concepts. 

Before starting this lesson, you should complete 
Chapter 8:  Building a Cut-out Puppet in the 
Toon Boom Animate Getting Started Guide. You can 
either do the rigging following the Animate method, using 
the timeline, or the Animate Pro one, using the network. 
To use the network, read the following topics:

• Ordering the Puppet’s Layers
• Setting the Pivots
• Connecting to a Composite Module
• Creating Hierarchies
• Ordering Layer Hierarchy
• Storing the Puppet in the Library

To follow these topics you can also use the bitmap 
puppet monster you imported while completing 
Chapter 2:  From Sketching Table to Animate Pro.
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If you select a layer and reposition it, its child layers will follow. There is no need to select all the layers.

Ordering the Puppet’s Layers

It is possible at this point that your character’s pieces show 
up in the wrong order. There are two ways to fix this.

Displayed in Front

Displayed
Behind

To reorder your layers drag them to a higher or lower level 
in the Timeline view. The top layer is displayed in front of 
the others and the bottom one is displayed behind.

In the 1. Timeline view, drag the layer to reorder it and 
drop it inbetween the other layers.  
Note: If you drop it on a layer, it will create a parent 
hierarchy, so make sure to drop it inbetween layers.
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For more information about pivots, refer to the Toon Boom Animate User Guide.

Setting the Pivots

If you want your puppet’s pieces to rotate properly, you 
need to set the pivot points. Even the eyes and mouth 
require you to set their pivot.

Do the following steps for each layer in the Timeline view.

To set the pivots for the Body parts:
In the Tools toolbar, select the 1. Pivot  tool.
In the Timeline view, select the cell you want to set 2. 
the pivot for.
In the Camera view, click where you want the pivot 3. 
to be. You can also drag the pivot marker to the 
desired location.
In the Timeline view, select the cell where you want 4. 
to set the new pivot.
In the Camera view move the pivot to the desired 5. 
position.
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Refer to the Toon Boom Animate User Guide to learn more about module types and the Module Library.

Connecting to a Composite Module

A composite module takes all the different parts of your 
puppet and combines them into one single image. This 
way, you can create effects and complete your scene with 
ease. 

If you do not already have a Composite module in your 
Network view, do the following:

In the Network view, use the default keyboard 1. 
shortcut [Ctrl]+[H] to add a Composite module.
In the Timeline view’s left side, select all of your 2. 
layers, using the [Shift] key.
Right-click (Windows) or [Ctrl]+ click (Mac OS X) and 3. 
select Connect to Composite> select your 
Composite module from the list.

All of the drawing modules are now connected to a 
Composite. The next step is to add a Master Peg to gather 
up all the pieces to be able to control your puppet. 

To add a master peg:
In the Network view, add a Peg module using the 1. 
default keyboard shortcut [Ctrl]+[P] (Windows) or 
[z]+[P] (Mac OS X).
In the Timeline view, make a multiple selection of all 2. 
your layers using the [Shift] key and drag the 
selection on the Peg layer.
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It is important to delete the Write module when building a cut-out puppet. A Write module is used to render 
portions of your network. If you have two characters in a scene, their render would overwrite the scene’s one.

The Network view might appear chaotic and tangled. You 
can use the Scripting toolbar to untangle your modules.

Select 1. Windows > Toolbars > Scripting to display 
the Scripting toolbar.
In the Network view, use the default keyboard 2. 
shortcut [Ctrl]+[A] (Windows) or [z]+[A] (Mac OS X) 
to select all the modules.
In the Scripting toolbar, click on the Order Network 3. 
Down  button. 
You can use the default values and click OK to 4. 
untangle your layers.

The basic rigging is almost done, these final few steps will 
make sure you optimize your puppet.

In the Network view, click on the Composite’s 1. 
Properties button. 
In the editor, enable the Pass Through option and 2. 
click on the Close button. This allows your 
character’s parts to move on the Z-axis and interact 
with other characters and manipulate props with 
ease.
If you do not already have one, add a Display 3. 
module in the Network view by dragging one from 
the Module Library and connect the Composite’s 
bottom port to the Display’s top port.
If you have a Write module in your network, select it 4. 
and delete it using the default keyboard shortcut 
[Delete].
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Refer to the Toon Boom Animate User Guide to learn more about complete production rigging.

Creating Hierarchies

Animate Pro lets you extend your rigging techniques 
beyond normal boundaries and set new standards. You can 
create hierarchies by creating a linked structure between 
them.

To create a hierarchy: 
Starting from your basic rigging, simply click and 1. 
drag the bottom port of the parent piece’s module 
(arm) and drag the connection to the top port of the 
child piece’s module (forearm).
Then, connect this piece (forearm) on to the other 2. 
child piece (hand).
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This is how your Network should look after the hierarchy is 
complete.
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Refer to the Toon Boom Animate User Guide to learn more about the Network view and its functionality.

Ordering Layer Hierarchy

Before After

As you work on your puppet and after you create a 
hierarchy for your arms, legs or other body parts, it is 
possible that you will notice that some parts do not appear 
in the correct order. If you move the forearm layer above 
the arm layer using the Timeline view, you will break the 
hierarchy. Luckily, reordering in the Network is as easy as a 
click and drag and will not modify the hierarchy.  

Top Bottom

On a Composite module, the bottom element is 
connected on the far right port and the top element is 
connected on the far left port. 

In the Network view, click and hold the Composite 1. 
port corresponding to the piece you want to 
reorder. 

Drag the selected connection to the new position 2. 
and release.
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Refer to the Toon Boom Animate User Guide to learn more about Group modules and the Library.

Storing the Puppet in the Library

To store your character in the Library, you first need to 
create a position keyframe on all your layers and finally 
group and store it as a template in a sharing library.

1. In the Timeline view, select the first frame of every 
layer.
In the top menu, select 2. Insert > Keyframe or use 
the default keyboard shortcut [Ctrl] + [F6] (Windows) 
or [z] + [F6] (Mac).
In the Network view, select all your modules and use 3. 
the default keyboard shortcut [Ctrl]+[G] (Windows) 
or [z]+[G] (Mac OS X) to group them into a Group 
module.
Click on the Group module’s right side black arrow 4. 
to enter the group.
From the Module Library, select a Multi-Port-Out 5. 
module and drag it into the Network view.
In the Network view, connect the Multi-Port-Out 6. 
module to the bottom of the Composite.
Click on Top from the Network view’s left part of the 7. 
status bar, to exit the Group module.
In the 8. Library view, select the Animate Pro Library 
folder, right-click (Windows) or [Ctrl]+click (Mac OS) 
and select Right To Modify.
In the Network view, select your group and use the 9. 
default keyboard shortcuts [Ctrl]+[C] and [Ctrl]+[V] 
(Windows) or [z]+[C] and [z]+[V] (Mac OS X) to 
copy and paste it into the Animate Pro Library.

You now have a complete cut-out puppet!
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Chapter 5  Compositing

In Toon Boom Animate Pro, there are many effects you can use to improve the quality of a project. 

In this chapter you will composite effects in a production-like context. Animate Pro allows you to composite your 
scene using a node system. In this lesson, you will perform the same tasks as the Creating Effects chapter from the 
Toon Boom Animate Getting Started Guide, but using the node network. In Animate Pro, you can not create effects 
from the Timeline view.

You can practice these effects on material you create 
from scratch or you can also use the sample material.

Undone_example_Sample_material > • 
Chapter5PRO_Sample_Material.tpl

The topics are: 
• Drawing Your Star Points
• Making Your Stars Twinkle
• Making your Stars Glow
• Fading your Stars
• Lighting Up the Lampposts
• Making it Shine in the Night
• Keeping Your Distance
• Preparing to Hit the Switch
• Hitting the Switch
• Shooting Star
• Putting On a Mask
• Editing the Mask
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If	you	want	five-point	stars	or	if	you	are	working	with	Animate	Pro	PLE,	you	can	select	a	star	shaped	brush	
from the Brush tool Properties and skip the next topic task.

Drawing Your Star Points

To build a starry night effect, we first need a layer of stars. 
In Animate Pro, select a round brush, pick a star colour, 
and draw dots where you want your stars on a new 
drawing layer! 

If you are working with Animate Pro PLE, use the star 
shaped brush and skip the next topic task.

In the Timeline view, click on the Add Layers 1.  
button to add a Drawing layer on top of your 
background. Name it Stars and click on its first cell.
In the Tools toolbar, select the Brush 2.  tool.
In the Tool Properties view, select a round shape 3. and 
customize the minimum and maximum size values so 
that you have a varied range of star sizes when you 
draw with your pen tablet.

In the Colour view, pick a star-like colour.4. 
In the Camera view, draw as many dots as you want 5. 
stars.
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Refer to Toon Boom Animate User Guide to learn more about the different options of the Sparkles effect 
module.

Making Your Stars Twinkle

(NOTE:This feature is not available in Animate Pro PLE 
version)

Now that you have drawn the positions of your stars, it’s 
time to make some magic and transform these points of 
light into stars. 

As you customize your effects, you can preview the final 
result in the Camera view. In the Camera view bottom 
toolbar, click on the Render  mode button. To update 
the preview, click on the Update Preview  button.

Display both the Network view and Module Library. 1. 
In the Module Library, under the Plugins tab, select 2. 
and drag a Sparkle Effect into your Network view.

In the Network view, select the Sparkle module, 3. 
hold down the [Alt] key as you drag it in between the 
Stars and Composite modules to connect it.

Click on the Sparkle module’s Properties to open 4. 
the Layer Properties dialog box and modify the 
Start Angle, Scale, Factor and Number of Points 
values to customize the look of your stars.
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Refer to Toon Boom Animate User Guide to learn more about connecting the modules and the Network view.

Making your Stars Glow

Now that you have stars in your project, it is time to make 
them shine! 

Display both the Network and Modules Library 1. 
views. 
In the Module Library view, select a Glow module 2. 
under the Filters tab and drag it into the Network 
view.

3. Click on the Sparkle module’s bottom port and drag 
it in the Glow module’s top port to connect it.

Connect the Glow module to the Composite.4. 
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In the Network view, click on the Glow module’s 5. 
Properties button to display the Layer Properties 
dialog box.

Set the Blur Radius value.6. 
Pick a colour and alpha value. Double-click on the 7. 
colour swatch to display the Colour Picker. 
Display the result in the Camera view using the 8. 
Render mode. 

Adding new layers in the Timeline view can result in a messy Network. Use the Order Network Down button in 
the Scripting toolbar to untangle the modules. Refer to Toon Boom Animate User Guide to learn more. 
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Refer to Toon Boom Animate User Guide to learn more about the Transparency effect module.

Fading your Stars

Now that your sky is glowing with stars, you might want to 
soften them a bit.Try adding a Transparency effect on your 
Star layer. 

Display both the Network and Module Library views.1. 
In the Module Library view, select a Transparency 2. 
module under the Filters tab and drag it into the 
Network view.

In the Network view, select Transparency module 3. 
and hold the [Alt] key as you drag it between the 
Sparkle and Composite modules.

In the Network view, click on the Transparency 4. 
module’s Properties button to modify the 
transparency value of your layer.

Display the result in the Camera view using the 5. 
Render mode. 
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When the Network view gets overcrowded, you can select modules and gather them inside Group modules 
using [Ctrl]+[G] (Windows) or [z]+[G] (Mac OS X). Refer to Toon Boom Animate User Guide to learn more.

Lighting Up the Lampposts

Lighting up the lampposts is as easy as making the stars 
shine. Only one step differs. You have to create a lamp 
layer from the background layer.

In the Timeline view, select the Bg layer’s first cell.1. 

In the Tools toolbar, select the Select 2.  tool.
In the Camera view, select the light bulb zones of 3. 
the two lampposts. Press [Shift]+Click as you select 
the zones to create a multi-selection.
Press the default keyboard shortcut [F9] to Create 4. 
Drawing from Drawing Selection. 
Name your new layer 5. light_matte.
Drag a Glow module effect from the Module Library 6. 
to the Network view.
In the Network view, connect the Glow module 7. 
under the light_matte module  and customize the 
effect.
Verify the result in the Camera view, using the 8. 
Render  mode.
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Refer to Toon Boom Animate User Guide to learn more about the Highlight module.

Making it Shine in the Night

Adding a halo around the lampposts and a highlight on 
the statue is an easy and effective way to enhance the 
glow effect and integrate all of the elements in the scene.

In the Timeline view toolbar, use the Add Layers 1.  
button to create a new drawing layer.
Name this new layer2.  Lamp_Highlight_matte.
In the Timeline view, select the first cell of the new 3. 
layer.
In the Tools toolbar, select the Ellipse 4.  tool.
In the Tool Properties view, enable the Auto Fill 5.  
mode.
In the Colour view, select any colour.6. 
In the Camera view, trace a large ellipse around the 7. 
lamp area, this shape will become your halo.
Display both the Network and Modules Library 8. 
views. 
In the Module Library view, select a Highlight 9. 
module under the Filters tab and drag it into the 
Network view.
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The Highlight module, unlike the Glow effect, will only 
affect specific layers. This means you need to connect the 
mask as well as the layer it will affect. In this case, it will be 
the Bg layer. 

In the Network view, connect the Highlight module 1. 
to the Composite module. 
Connect the Lamp_Highlight_matte module into 2. 
the left port of the Highlight module. 
Connect the Bg module into the right port of the 3. 
Highlight module.
Click on the Highlight module’s Properties button 4. 
and customize the effect.
Verify the result in the Camera view using the 5. 

Render  mode. 

The statue highlight effect will follow 
similar steps.

In the Timeline view, create a 1. 

new layer   and name it 
Statue_Highlight_matte.
In the Timeline view, select the 2. 
first cell of the new layer.
In the Camera view, paint the 3. 
highlight zones using the 

Brush  tool.
I4. n the Module 
Library view, select a 
Highlight module and 
drag it into the Network view.
In the Network view, connect 5. 
the Statue_Highlight_
matte module into the left port 
of the Highlight module and 
connect the Statue module into the 
right port .
Customize the highlight effect.6. 
Verify the result in the Camera view 7. 
using the Render  mode. 
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Refer to Toon Boom Animate User Guide to learn more about the Blur-Radial effect module.

Keeping Your Distance

A good way to increase an illusion of depth is by using an 
overlay which is out-of-focus. In this example we will be 
hiding behind a broken structure.

Display both the Network view and Modules Library. 1. 
In the Module Library view, select a Blur-Radial 2. 
module under the Favourites tab and drag it into the 
Network view.
In the Network view, select and hold the [Alt] key as 3. 
you drag the Blur-Radial module in between the Ol 
and Composite modules to connect it.

Click on the Blur-Radial module’s Properties button 4. 
to customize the Radius value of the effect.

In the Camera view, verify the result using the 5. 
Render  mode.
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Refer to the Toon Boom Animate User Guide to learn more about keyframes and functions.

Preparing to Hit the Switch

All these effects can be animated over time. For this 
example, we will progressively light up the lampposts 
making their glow, halo and the statue’s highlight 
gradually appear. 

In the Module Library view, drag1.  three Transparency 
effects to the Network view. 

In the Network view, connect the 2. 
lamppost’s Glow layer into one of the 
Transparency layers.

Connect the matte shape layers of the 3. 
two Highlight effects into the two remaining 
Transparency layers.

With these Transparency layers you will 
create a fade in effect, making the scene go 
from lights out, to lights on. 

Now we need to extend the drawing 
                       exposure.

In the Timeline view, make a multi-selection which 1. 
includes the last cell of each layer using [Shift]+Click 
and press [F5].
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Hitting the Switch
Now is time to create a function and enter the keyframes 
that will animate the Transparency effects and gradually 
light up your scene. 

In the Timeline view, click on the Expand 1.  button 
to display the Data view.

In the Timeline view, click on the Transparency layer 2. 
Expand  button to display the Transparency’s 
function.

Make sure that your timeline marker is on the first 3. 
cell, click on the Add Keyframe  button and enter 
the first Transparency value. This keyframe should 
be set to 100 so that the lights are out.

Move the timeline marker to the last frame of your 4. 
scene and press the Add Keyframe  button and 
enter the last transparency value. This value should 
be set to 0 (zero) to light up the scene completely.

Repeat 5. Step 1 to Step 4 for the other two  
Transparency layers.
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Refer to Toon Boom Animate User Guide to learn more about the Play view and previewing your scene as well 
as exporting your scene.

Follow these simple steps to preview your  animated 
effect. 

In the Playback toolbar, press on the Render and 1. 
Play  button.

Your frames will be calculated and the Play view will 2. 
pop up. 
In the Play view, press on the Play 3.  button and 
enjoy your scene!
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When animating the shooting star, make sure that the Peg Selection Mode  in the Transform tool  
Properties view is disabled.

Shooting Star

Now, to make things more interesting, let’s add a shooting 
star flying across the heavens. Use the disabled module 
Shooting_Star which we have provided.

In the Network view, select and enable the 1. 
Shooting_Star module using the default keyboard 
shortcut [A].

A

B

To animate the shooting star:
In the Tools toolbar, click on the Animate 1.  button 
and then select the Transform  Tool.

In the Timeline view, click on the first cell of the2.  
Shooting_Star layer.
In the Camera view, click and drag the shooting star 3. 
to its first position on the extreme left, outside of 
the camera frame.
In the Timeline view, click on the last cell of the 4. 
Shooting_Star layer.
In the Camera view, click and drag the shooting star 5. 
across the screen, ending at it’s final position.

The system will automatically create the motion between 
the two keyframe positions.

[A]
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By default, the preferences are set to Motion Keyframes, this means that the system will automatically create 
the motion between the two keyframes of the shooting star.

The shooting star now moves at a constant speed along 
the straight line from point A to point B. To add a curve 
and a velocity effect, follow these steps.

In the Timeline view, select the Shooting_Star layer.1. 
Select 2. View > Show > Control to display the 
trajectory.
In the Camera view, position your cursor over the 3. 
trajectory and press [P] to add a control point.
In the Camera view, click and drag the new control 4. 
point to create a curve.

In the Control Point toolbar, adjust the Tension and 5. 
Continuity values to set your trajectory’s curve.

To add a velocity effect:
In the Timeline view, click on the Expand 1.  button 
to display the Data view.
In the Timeline view, click on the Expand Arrow 2.  
and Expand  buttons of the Shooting_Star layer 
to display its functions.

In the Timeline view, double-click on the Position 3. 
Velocity function of the shooting star layer.

The Velocity Editor dialog box opens.

In the Velocity Editor dialog box, click on the last 4. 
keyframe and drag the handle toward the centre to 
create a velocity curve.
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Refer to the Toon Boom Animate User Guide to learn more about Trajectories, Control Points and the Velocity 
Editor.

Putting On a Mask

Now the shooting star is all set, only one thing is left to do. 
Since the lampposts are part of the Bg layer, the star 
cannot pass behind them. For this reason, we will add a 
Cutter module and drawing that will hide the shooting star 
when it passes in front of the lampposts, giving the illusion 
of passing behind. For this lesson, a matte drawing of the 
lampposts is provided for you. 

 
In the Network view, enable the Lamp_Mask layer 1. 
using the default keyboard shortcut [A].
In the Module Library view, select a Cutter module 2. 
under the Filters tab and drag it into the Network 
view.
In the Network view, connect the Lamp_Mask 3. 
module to the Cutter module right port, the 
Shooting_Star group module in the left port and 
connect the Cutter module into the Composite 
module.

The shooting star will now cross the screen behind the two 
lampposts!
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Refer to the Toon Boom Animate User Guide to learn more about Cutter and Effects. 

Editing the Mask

Once a matte drawing module is connected to a Cutter 
effect the drawing will become invisible in the Camera 
view, as it will automatically be applied as a mask. If you 
need to edit your matte drawing after you create your 
connections in the Timeline view, you can easily make your 
drawing visible without breaking the connections. 

In the Network view, connect the Lamp_Mask 1. 
module directly into the Composite module without 
changing the current connection via the Cutter 
module.

This will automatically render your drawing visible in the 
Camera view. It will be displayed on top of all other layers, 
making the editing easy to do.

In the Tools toolbar, select the drawing tools you 1. 
need and edit the matte in the Camera view.
When you are done, simply disconnect the Lamp_2. 
Mask module from the Composite module, keeping 
it connected only via the Cutter module.     
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